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xi Related documentation

               
Welcome to the User’s Guide for the Fiery 500. This manual gives an overview of 
desktop color concepts and issues and describes how to maintain and calibrate the 
printer. It explains how to configure and print from various platforms—PostScript 
printing from the Macintosh and PostScript and PCL printing from Windows 95/
98 and Windows NT 4.0.

The audience for this manual is anyone who needs to maintain color consistency 
and print to the printer at your site.

The following major topics are included:

• Color printing

• Printing from Macintosh and PC-compatible computers

• Printing from popular applications

• Using Fiery WebTools to manage print jobs 

• Fonts and additional font utilities

Related documentation
This guide is part of a set of printed documentation for the printer that also 
includes the following:

• Quick Installation Guide describes the procedures for installing your printer.

• Printer Reference describes the necessary information on using your printer and 
its optional equipment.

• Getting Started provides step-by-step instructions on how to set up your 
Fiery 500 and how to install user software onto client workstations.

• User’s Guide provides an introduction to desktop color printing, how to print 
from various computers and workstations, what you need to know about using 
the printer in a networked environment, and how to use the software provided.

• Printed Release Notes describe last-minute product information and 
workarounds for some of the problems you may encounter. 

Preface
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Conventions

Indicates functionality for which a hard disk drive is required.
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This chapter introduces concepts that are basic to color theory. You will encounter 
some of these concepts (such as hue, saturation, and brightness) when you work 
with color in applications; others provide useful background information. Color is 
a complex topic, so consider this a starting point for experimentation and further 
research.

The properties of color
What we call “color” is really a perceptual ability unique to humans and a small 
number of animal species. Color theory is an attempt to systematize the properties 
of color perception, which by nature is relative and changeable. A color appears 
different depending on the other colors around it, and individuals vary in their 
abilities to perceive color. 

The physics of color
The human eye can see electromagnetic radiation at wavelengths between 400 
nanometers (purplish blue) and 700 nanometers (red). This range is called the 
visible spectrum of light. We see pure spectral light as intensely saturated or pure 
colors. Sunlight at midday, which we perceive as white or neutral light, is 
composed of light from across the visible spectrum in more or less equal 
proportions. Shining sunlight through a prism separates it into its spectral 
components, resulting in the familiar rainbow of colors.

Like the sun, most light sources we encounter in our daily environment emit a 
mixture of many light wavelengths, although the particular distribution of 
wavelengths can vary considerably. Light from a tungsten light bulb, for example, 
contains much less blue light than sunlight. Tungsten light appears white to the 
human eye which, up to a point, can adjust to the different light sources. 
However, color objects appear different under tungsten light than they do under 
sunlight because of the different spectral makeup of the two light sources.

The mixture of light wavelengths emitted by a light source is reflected selectively 
by different objects. Different mixtures of reflected light appear as different colors. 
Some of these mixtures appear as relatively saturated colors, but most appear to us 
as grays or impure hues of a color.

Chapter 1:
Working 
with Color
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CIE color model
In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a 
standard color space, a way of defining colors in mathematical terms, to help in 
the communication of color information. This color space is based on research on 
the nature of color perception. 

By mixing any two spectral colors in different proportions, we can create all the 
colors found between them. For example, it is possible to create the same gray by 
mixing blue-green and red light or by mixing yellow-green and blue-violet light. 
This is possible because of a phenomenon peculiar to color vision called 
metamerism. The eye does not distinguish individual wavelengths of light. 
Therefore, different combinations of spectral light can produce the same perceived 
color. 

Hue, saturation, and brightness
A color can be described in terms of three varying characteristics: 

• Hue, or tint (the qualitative aspect of a color—red, green, or orange)

• Saturation, or the purity of the color

• Brightness, or relative position between white and black. 

Many computer applications include dialog boxes in which you choose colors by 
manipulating hue, saturation, and brightness. For example, Photoshop uses a 
square Color Picker which can be reconfigured according to your preference.

Additive and subtractive color systems
Color devices used in desktop publishing and printing simulate the range of visible 
colors using a set of primary colors that are combined to create other colors. There 
are two methods of creating a range of colors from a set of primary colors. 
Computer monitors and scanners use the additive color model. Printing 
technologies, including Fiery 500 print devices and offset presses, use the 
subtractive color model.
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Additive (RGB) color

Color devices that use the additive color model make a range of colors by 
combining varying amounts of red, green, and blue light. These colors are called 
the additive primaries. White is created by adding the maximum amount of red, 
green, and blue light available. Black occurs wherever all three colors are absent. 
Grays are created by adding varying amounts of all three colors together. 
Combining varying amounts of any two of the additive primaries creates a third, 
saturated hue.

A familiar device that uses this color model is the computer monitor. Monitors 
have red, green, and blue phosphors that emit varying amounts of light to display 
a given color. Scanners create digital representations of colors by measuring their 
red, green, and blue components through colored filters.

Subtractive (CMY and CMYK) color

The subtractive color model is used in color printing, and in color photographic 
prints and transparencies. While the additive color model simulates the visible 
spectrum of color by adding light of three primary hues, the subtractive color 
model uses a “white” or neutral light source containing light of many wavelengths. 
Inks, toners, or other colorants are used to selectively absorb (subtract) certain 
wavelengths of light that otherwise would be reflected or transmitted by the media 
in question. 

The subtractive primaries are cyan, magenta, and yellow; they absorb red, green, 
and blue light, respectively. Combining any two subtractive primaries creates a 
new color that is relatively pure or saturated. For example, you can make red by 
combining magenta and yellow, which absorb green and blue light, respectively. 
White occurs when no colorant is applied. Combining all three subtractive 
primaries in theory yields black, but due to deficiencies of cyan, magenta, and 
yellow colorants, combining these three primaries actually yields a muddy brown. 
Black colorant is added to compensate for the deficiencies of cyan, magenta, and 
yellow colorants, and consequently color printing uses four process colors: Cyan, 
Magenta, Yellow, and blacK  (CMYK). The use of black ink helps in producing 
rich solid blacks and also allows for improved rendition of black text.
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Print device gamut
Different color reproduction techniques have different color capabilities, or 
gamuts. Color transparency films have comparatively large gamuts, as do color 
monitors. The color gamut that can be produced using CMYK toners on paper is 
smaller. This is why some colors that can be displayed on a color monitor, 
especially bright saturated colors, cannot be reproduced exactly by your Fiery 500 
print device—nor, for that matter, can they be reproduced on press using process 
colors. Moreover, different print devices have different gamuts—some colors that 
your print device can produce cannot be reproduced on an offset press, and vice 
versa. The following illustration provides a graphical representation of this 
concept.

You need to account for the gamut of your print device when designing on a color 
monitor. When printed, colors that fall outside the print device’s gamut are 
“mapped” to printable colors. This process, referred to as gamut mapping, takes 
place when color data is converted or adjusted to meet the color space and gamut 
requirements of a print device. 

The Fiery 500 is specially designed to perform gamut mapping at high speed with 
high quality results. It provides these color management features automatically, 
using either built-in default settings or settings that you specify for a particular 
print job. For added flexibility, the Fiery 500 color management system can also 
be used in combination with color management systems on Macintosh and 
Windows computers See “Rendering styles” on page 1-18.

Color transparency film

Other print device

RGB monitor

Offset press (white)
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Controlling printed color
When working with color materials, whether they be presentations, illustrations, 
or complicated page designs, you make aesthetic decisions about the colors you 
use. Once you have decided on your goal, you then need to realize it in print. Your 
color printing system becomes an ally in this creative process to the extent that 
you can get results that are predictable. 

• If you have designed a brochure to print on the Fiery 500, you want the printed 
colors to match the design specification.

• If you are printing presentations on the Fiery 500, you want to preserve the 
vivid colors in the monitor display. 

• If you are working with color that will print on press, you want the Fiery 500 
output to match prepress proofs. 

The type of print job and the final print device either the Fiery 500 printer or an 
offset press, determine the methodology you use to achieve optimal results. 

No matter what your goals are, two hardware factors always impact color print 
output: print device consistency and the range of colors the print device can print, 
known as its gamut. These factors are covered briefly in this chapter. Creating 
successful color documents and presentations also requires an understanding of 
color management software as it is implemented by the Fiery 500 and on your 
desktop computer. Most of this chapter is devoted to discussing the various 
elements of color management that contribute to predictable color results. 

Maintaining print device consistency
The factors described below affect print device consistency, as well as color fidelity 
and overall output quality.

Paper stock and toner 
The paper and toner used by the print device can greatly affect printed color. For 
best results, use the consumables recommended by the manufacturer of your 
printer. 
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Maintenance
Problems such as streaking and insufficient or excessive amounts of one or more 
toners arise when a print device does not receive periodic maintenance. In 
addition to having it serviced regularly, monitor the color production of your 
printer by making standard test prints at regular intervals. You can do this easily 
by printing the Fiery 500 Test Page from the operation panel. Save the prints and 
show them to your system or site administrator if recalibration becomes necessary.

Calibrating the printer

VisualCal calibration
VisualCal is a calibration method that allows you to recalibrate your printer to an 
ideal color output standard defined by the printer’s manufacturer. The calibration 
calculations performed by the controller software are based on a series of values 
entered on the operation panel. The values used in the calculations are determined 
by evaluating toner densities and color combinations produced on two specially 
designed calibration pages printed from the operation panel.

For information on how to use the operation panel, see Getting Started.

Limits and 30% Match

The first VisualCal page, “Limits and 30% Match,” provides the basis for 
calculating the most acceptable luminosity (brightness) of the toners. This page 
consists of rows of CMYK dots in a graduated range of toner densities.

The variables needed to recalculate the density of the colored toners are 
determined by identifying the leftmost dots that can be fully distinguished against 
their fields in each row, and sequentially entering their corresponding numeric 
values on the operation panel. The variable needed to recalculate the luminosity of 
the toners is determined in a slightly different way—you identify the black dot 
which best matches a 30% dot gain field. When all values have been entered, the 
printer’s toner density and luminosity settings are recalculated.
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Gray Balance

The second VisualCal page, “Gray Balance,” provides the basis for calculating a 
“neutral gray balance,” that is, a CMY gray that as closely as possible matches a 
pure K (BlacK) gray produced by the printer’s engine. This page consists of rows 
of CMY gray patches on a field of gray produced solely from black.The variables 
needed to calculate the printer’s most neutral gray balance are determined by 
identifying the CMY patch that best matches this field, and entering its row and 
column location on the operation panel. When the values have been entered, the 
printer’s gray balance is recalculated.

TO PERFORM VISUALCAL CALIBRATION:

1. From the READY screen, press the Menu key and then the up arrow key to advance 
to the VISUALCAL screen.

NOTE: If the printer is in ENERGY SAVE MODE, you must wait for the printer to warm 
up before you can perform calibration.

2. Press Enter to advance to the PRINT LIMITS screen. To print the Limits and 30% 
Match page, use the up and down arrow keys to select YES. Press Enter to print the 
page.

To reset the printer’s toner density and luminosity settings, follow the instructions 
provided on the Limits and 30% Match page.When you have finished entering all 
values, the PRINT GRAYS screen appears. 

NOTE: Zero (0) and 9 are unacceptable values for color calibration. If you select 0 
for any of the colors, the resulting calibration will be inaccurate. If the entered 
value for any color is 9, the Limits and 30% Match page is reprinted 
automatically. Re-enter values for all color rows starting with Black Start.

3. To print the Gray Balance page, use the up and down arrow keys to select YES. 
Press Enter to print the page.

To reset the printer’s gray balance, follow the instructions provided on the Gray 
Balance page. When you have finished entering all values, the PRINT COLOR TEST 
screen appears. 

NOTE: If the Gray Balance page is printed after the Limits calculations have been 
made, the gray field on which the CMY patches appear on the Limits page will use 
the new density and luminosity calibration settings.
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4. To print a Color test that uses the original values (CURRENT COLOR TEST PAGE) and 

a Color test that uses the new values (NEW COLOR TEST PAGE), use up and down 
arrows to select YES, and press Enter to print the pages.

The Color Test pages are in the same format as the Test page which you can print 
from the PRINT PAGES FROM LIST menu.

Before applying the calibration changes compare the Color test that uses the 
original calibration values against the Color test that uses the new values.

5. If you are satisfied with the printer’s calibration based on the new values, select 
YES from the APPLY CHANGES screen that appears, and press Enter to recalibrate 
the printer based on the previously entered values.

Adjusting VisualCal values

Consider the following suggestions for adjusting VisualCal for your specific 
preferences:

• If your print seem to be color balanced but too dark, enter a lower value for the 
30% Match entry on the Limits and 30% Match page, last row.

• If your print seems too light, enter a higher value.

• If light areas on your prints have a color cast, enter a lower value in the Start row 
for that toner.

• If dark areas on your prints have a color cast, enter a higher value in the End 
row for that toner.

Color adjustment
The printer’s color adjustment feature provides additional creative control over 
printer’s color production. The color adjustment screens, accessible via the 
operation panel, allow you to override the printer’s current toner density and 
brightness settings.

Using the color adjustment controls, you can also increase or decrease the 
brightness of an image, or you can increase or decrease the density of each the 
following colors: red, yellow, green, cyan, blue or magenta. For example, you may 
choose to emphasize the bright, blue sky in an image by increasing the density of 
the blue and the cyan in the image, and increasing the brightness setting. 
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TO PERFORM COLOR ADJUSTMENT:

1. From the READY screen, press the Menu key and then the up arrow key to advance 
to the COLOR ADJUSTMENT screen. Press Enter.

NOTE: If the printer is in ENERGY SAVE MODE, you must wait for the printer to warm 
up before you can perform color adjustment.

2. Use the up and down arrow keys to specify an increase or decrease in the overall 
brightness of printed documents. Press Enter.

Negative values are darker, positive values are lighter. 

3. Use the up and down arrow keys to select a color to be adjusted, and press Enter.

4. Use the up and down arrow keys to increase or decrease the density of the 
selected color. Press Enter.

Negative values are lighter, positive values are darker. 

5. To print a Color test that uses the original values (CURRENT COLOR TEST PAGE) and 
a Color test that uses the new values (NEW COLOR TEST PAGE), use up and down 
arrows to select YES. Press Enter to print the pages.

The Color Test pages are in the same format as the Test page which you can print 
from the PRINT PAGES FROM LIST menu.

6. To apply the new color and brightness values, use the up and down arrow keys to 
select YES. 

NOTE: Changes made using Color Adjustment are retained until the printer is 
recalibrated. You can reset the adjusted colors to the last calibration made using 
the RESET ALL TO 0 option in the Adjust Color screen; recalibrate the printer using 
VisualCal, or reset the printer’s color production to factory defaults using the 
operation panel’s RESETS>RESET COLOR option. 
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Using color effectively
The ability to print in color can greatly increase the effectiveness of your message, 
whether you are printing a presentation or a newsletter, or proofing an ad concept 
that will later be printed on press. Some potential benefits of using color include:

• Conveying information rapidly by using color cues

• Making use of the emotive aspects of different colors

• Increasing impact and message retention 

Color can also be a source of distraction and discord if it is used poorly. This 
section outlines some tips and concepts that will prove useful as you approach 
designing color materials.

A few rules of thumb
Try some of the following strategies for creating successful color materials:

• Rather than applying colors indiscriminately, use color to aid comprehension. 
In presentations, graphs, and charts, use color to highlight patterns and 
emphasize differences. 

• In general, fewer colors work better than many colors.

• Use red as an accent color. Red is particularly effective when used in otherwise 
monochromatic materials.

• Consider the tastes of your target audience when choosing colors. 

• Keep a file of printed color pieces that appeal to you or strike you as effective. 
Refer to it for ideas when designing your own documents.
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Color wheel
A color wheel is a helpful tool for understanding the interrelation of colors. The 
colors on one side of the color wheel, from magenta to yellow, appear to most 
people to be warm colors, while those on the other side, from green to blue, 
appear to be cool. The distance between two colors on the color wheel can help 
predict how they will appear when seen side by side. Colors opposite one another 
on the wheel are called complements, and create a striking contrast side by side. 
This can be the basis for a bold graphical design, but it is an effect you should use 
with discretion since it can be visually fatiguing. Other bold combinations to 
consider are split complements (a color and the two colors adjacent to its 
complement) and triads (three colors evenly spaced on the color wheel). Colors 
adjacent to one another on the color wheel result in subtle harmonies.

The color wheel simplifies color relationships for the purpose of clarity, showing 
only saturated or pure colors. Adding the myriad variations of each hue to the 
palette (more or less saturated, darker or lighter) creates a wealth of possibilities. 
Taking a pair of complements from the color wheel and varying the saturation and 
brightness of one or both colors produces a very different result from the pure 
complements. Combining a light tint of a warm color with a darker shade of its 
cooler complement often gives pleasing results. Combining a darker shade of a 
warm color with a light tint of its cooler complement produces an unusual effect 
you may like.

Once you have mastered the concept of the color wheel, you have a good 
framework for experimenting with color combinations. Many books targeted at 
graphic designers show groups of preselected color combinations. Some are 
organized by themes or moods, and some are based on a custom color system such 
as PANTONE. The more you develop a critical facility for judging color 
combinations, the more you will be able to trust your own eye for color.

Color and text
It is not a coincidence that the overwhelming majority of text you see is printed in 
black toner on white paper. Text in black on white is highly legible and is not 
fatiguing to read for extended periods. For many color materials, using black text 
on a white background and confining color to graphic elements and headings is a 
good choice.



1-12 Working with Color1

Color text can add flair to documents printed on paper when used skillfully, and is 
widely used in presentations. When using color text, avoid dazzling text and 
background combinations created from primary complements, especially red and 
cyan or red and blue; they are visually fatiguing and hard to read. Color text is 
more legible when distinguished from its background by a difference in 
lightness—for example, dark blue text on a light beige background. In addition, 
using many different colors in a string of text makes for a confused appearance 
and is hard to read. However, using a single highlight color is an effective way to 
draw the reader’s eye to selected words.

When using color text, keep in mind that small font sizes typically do not print in 
color with the same sharpness as in black. In most applications, black text prints 
exclusively in black toner while color text usually prints with two or more toners. 
Any misregistration between the different toners on paper causes color text to lose 
definition. You can make test prints to find the smallest point size at which color 
text prints clearly. When using high-end graphics applications that allow you to 
specify color as percentages of cyan, magenta, yellow, and black, you can create 
pure cyan or pure magenta text that prints with the same sharpness as black text. 
(Pure yellow text is extremely hard to read on anything but a dark or 
complementary background.)

Raster images and vector images
Two broad categories of artwork can be printed from a personal computer to a 
color printer: raster and vector images.

A raster image, also referred to as a bitmap, is composed of a grid of pixels, each 
assigned a particular color value. The grid, when sufficiently enlarged, resembles a 
mosaic made from square tiles. Examples of raster images include scans and 
images created in painting or pixel-editing applications, such as Photoshop and 
Painter.

The amount of information found in a raster depends on its resolution and bit 
depth. The resolution of a raster describes the density of the pixels and is specified 
in pixels per inch (ppi). The bit depth is the number of bits of information 
assigned to each pixel. Black and white rasters require only one bit of information 
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per pixel. For photographic quality color, 24 bits of RGB color information are 
required per pixel, yielding 256 separate levels of red, green, and blue. For CMYK 
images, 32 bits per pixel are required.

When printing raster artwork, the quality of the output depends on the resolution 
of the raster. If the raster’s resolution is too low, individual pixels become visible in 
the printed output as small squares. This effect is sometimes called “pixelation.” 

In vector images, picture elements are defined mathematically as lines or curves 
between points—hence the term “vector.” Picture elements can have solid, 
gradient, or patterned color fills. Vector artwork is created in illustration and 
drawing applications such as Illustrator and CorelDRAW. Page layout applications 
such as QuarkXPress also allow you to create simple vector artwork with their 
drawing tools. PostScript fonts are vector-based as well. 

Vector artwork is resolution-independent; it can be scaled to any size without 
danger of pixels becoming visible in printed output. 

Optimizing files for processing and printing
The following sections provide tips on how to create image files that produce the 
highest possible print quality while minimizing the processing time and disk space 
they require.

Resolution of raster images
While a 72 ppi raster image appears sharp on a monitor, the same image would 
likely appear pixelated when printed to the Fiery 500. Color print devices are 
capable of much greater detail than monitors, and require correspondingly higher 
resolution image files. However, high-resolution files can be large, and therefore 
cumbersome to transmit over a network, process for printing, store on disk, and 
edit. 

Beyond a certain threshold, a higher image resolution greatly increases file size 
while having a minimal effect on output quality. The optimal image resolution 
depends on the resolution of the final print device. Aim for the resolution that 
optimizes both file size and output quality.
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The resolution of a raster, along with its bit depth and physical dimensions, 
determine its file size. The following table shows the file sizes of color raster images 
at different dimensions and resolutions.

In this table, the shaded areas indicate that 200 ppi is typically the best trade-off 
between image quality and file size. However, higher resolutions (e.g., 250 to 
300 ppi) may be needed for offset printing, when quality is of the utmost 
importance, or for images containing sharp diagonal lines.

To find the best image resolution for your purposes, make test prints of some 
raster artwork at different resolutions. Start with a high-resolution image 
(400 ppi) and save versions at progressively lower resolutions, down to 100 ppi, 
using a pixel-editing application such as Photoshop. Always save a copy of the 
original high-resolution version in case you need to revert to it. The high-
resolution data cannot be recreated from a lower resolution version. 

File size at:

Image size 100 ppi 150 ppi 200 ppi 400 ppi

RGB/CMYK RGB/CMYK RGB/CMYK RGB/CMYK

3" x 4" 0.4/0.5 MB 0.8/1.0 MB 1.4/1.8 MB 5.5/7.3 MB

5" x 7" 1.0/1.3 MB 2.3/3.0 MB 4.0/5.3 MB 16.0/21.4 MB

8.5" x 11" 2.7/3.6 MB 6.0/8.0 MB 10.7/14.3 MB 42.8/57.1 MB
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Print the files and examine the output. You will likely begin to see a marked 
deterioration in output quality at resolutions below 200 ppi, while above 200 ppi 
the improvement may be very subtle. 

Raster images prepared for offset printing may need to be at higher resolutions 
than needed for proofing on your Fiery 500. 

Scaling 
Ideally, each raster image should be saved at the actual size it will be placed into 
the document and at the optimal resolution for the print device. If the image 
resolution is correct for the print device, there is no quality advantage to be gained 
by scaling an image down to a percentage of its actual size. If you scale a large 
image down to a percentage of its actual size, you incur unnecessary file transfer 
time because the image data for the entire large image is sent to the printer. If an 
image is placed multiple times at a markedly different sizes in a document, save a 
separate version of the image at the correct size for each placement.

If you need to place an image at greater than 100% in a document, remember that 
the output image resolution is affected. For example, if you scale a 200 ppi image 
to 200%, the image is printed at 100 ppi.

100 ppi 200 ppi 300 ppi 400 ppi

Image quality

Image resolution
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Color management on the Fiery 500
The Fiery 500 uses a simple and flexible color architecture that produces excellent 
color results with default settings. It also allows you to customize your color results 
using various color controls.

Settings for the following Fiery 500 options can be specified using print dialog 
box options when you send a job. Some can also be set as defaults during 
Fiery 500 Setup on the operation panel. Settings specified in the print dialog box 
override equivalent settings in the printer setup on the operation panel.

Explanations of how these settings affect your print jobs are provided in the 
following sections.

Color print option: What it does:

RGB Source 
EFIRGB/sRGB (PC)/
Apple Standard/Off 
(Default value is sRGB) 

Applies an RGB source space definition to RGB data 
(see page 1-17). 

NOTE: RGB Source is available only with the 
PostScript printer driver.

Color Rendering Dictionary 
Photographic/Presentation/
Transparency (OHP)

Applies a Fiery 500 color rendering dictionary 
(CRD) to objects (text, photographs and 
illustrations) in a RGB data file (see page 1-18). 

Brightness 
85% to 115%
(Default value is 100%)

Performs a color adjustment on all color channels to 
make the printed output lighter or darker.

CMYK Simulation 
SWOP-Coated/DIC/Euroscale/
None
(Default value is None)

Adjusts CMYK color data to simulate an offset press 
standard or a custom color gamut defined at your 
site. Choosing None bypasses simulation. 

NOTE: CMYK Simulation is available only with the 
PostScript printer driver.
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RGB Source and Rendering Style
The RGB Source option is used to provide a source color space definition for 
RGB data in your document. The setting you specify for this option overrides any 
source color space profiles you may have specified using other color management 
systems. For example, if you specified a ColorSync System Profile on the 
Macintosh computer, the RGB Source setting specified in the Print dialog box 
overrides it. In cases where you don’t want this setting to override another 
specified source color space, choose Off.

PostScript RGB data is converted to CMYK data using the CRD specified by the 
Rendering Style option (see page 1-18). This type of RGB data contains its own 
source color space information which is used as a reference point for the 
conversion.

NonPostScript RGB data does not contain source color space information and so 
cannot be converted using a CRD. NonPostScript RGB data is converted using a 
general under-color-removal conversion method.

RGB Source: Description:

EFIRGB The source color space defined by this setting is optimal for 
color conversions that will be sent to a Fiery 500 print device. 
It also allows for consistent output across different operating 
systems. 

sRGB (PC) The sRGB (PC) setting specifies the source space of a generic 
Windows computer monitor.

Apple Standard The Apple Standard setting specifies the source space of all 
standard Macintosh computer monitors.
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Rendering styles
The Color CRD options are used to specify a CRD for color conversions. The 
following table describes the color rendering styles (CRDs) for Fiery 500 software 
and provides guidelines on when to use each one. Each color rendering style uses a 
different gamut mapping method, such as Photographic or Presentation, designed 
for a particular kind of color usage. 

NOTE: The rendering styles in the table cannot be used when specifying a target 
device profile with a color management system such as ColorSync or ICM.

Rendering style: Best used for:

Photographic—Preserves tonal relationships in images 
rather than exact colors. This rendering style maps out-of-
gamut RGB colors to printable colors in a way that retains 
differences in lightness. Color accuracy is sacrificed slightly 
in favor of presenting color relationships in the way the 
human eye perceives them. Photographic rendering typically 
gives less saturated output when printing out-of-gamut RGB 
colors than Presentation Color rendering does.

Continuous tone 
photographs, including 
scans and images from 
stock photography CDs

Presentation—Creates bright saturated colors. This 
rendering style does not try to match printed colors precisely 
to displayed colors but instead provides vibrant, dense colors. 
Photographic images, however, are treated the same way as 
by the Photographic rendering style. 

Artwork and graphs in 
presentations and 
continuous tone 
photographs

Transparency (OHP)—Improves the correspondence 
between monitor colors and printed color on transparency 
paper. 

Artwork and graphs 
printed on transparency 
paper
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CMYK Simulation
If you are using the Fiery 500 to print proofs for an offset press job or to simulate 
another print device, choose the appropriate CMYK Simulation setting. The 
CMYK Simulation setting specifies the offset press standard or other color gamut 
that you want to simulate.

The CMYK Simulation setting you should specify depends on the press standard 
for which the CMYK data was separated. For example, for images that were 
separated for SWOP-Coated paper, choose SWOP-Coated as the CMYK 
Simulation setting. Select SWOP-Coated to simulate printing to a standard 
American offset press; Euroscale to simulate a European offset press, or DIC to 
simulate a standard Japanese offset press. For images that were separated using a 
custom separation (such as a device-specific separation or a separation produced 
with an ICC-profile), choose None as the CMYK Simulation setting.
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This chapter describes installing software and setting up printing from a 
Macintosh computer.

Serial port printing from Macintosh computers is not supported by the Fiery 500. 
For instructions on how to connect your printer to a network, see Getting Started. 

General steps for installing Macintosh software
The general steps for installing the Fiery 500 software from the CD and setting up 
printing from a Macintosh computer are:

• Enable Ethernet and AppleTalk from the printer’s operation panel.

• Enable AppleTalk in the Chooser on the Macintosh.

• Install the Adobe PostScript Printer Driver.

• Set up the Fiery 500 in the Chooser.

• Copy additional color reference files, sample files and font files from the User 
Software CD as needed.

See Getting Started for details on installing Macintosh software.

Printing from a Macintosh application
On the Macintosh, custom print options are specified in the Page Setup and Print 
dialog boxes.

TO PRINT FROM A MACINTOSH APPLICATION:

1. Make sure that any printer description files needed by the application are 
installed on your Macintosh.

See Getting Started for instructions.

2. Open the file you want to print from within the application.

Chapter 2:
Printing from 
Macintosh 
Computers
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3. Choose Page Setup from your application’s File menu.

4. Select the Fiery 500 from the Format for: pop-up menu.

5. Select the print options you want from the dialog box.

PostScript and Page attribute options can be specified from this dialog box. 

6. Choose Print from the application’s File menu. 

Choose the number of copies you would like to print, the range of pages to print, 
and the paper source (tray) to print from. 

7. Choose additional Printer Specific Options from the Print dialog’s pop-up menus.

Each printer specific print option is described in the following section.

Options selected from the Print dialog override any duplicate settings specified in 
the Printer Setup on the printer. 
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Macintosh print options
The PostScript drivers that come with your printer have been customized to 
provide additional print options specific to your Fiery 500 printer. These options 
have been transparently integrated into the PostScript driver interface. 

Fiery 500 PostScript print options are described in the following table.

Printer Specific Option: Description:

Brightness 
85% to 115%
(Default value is 100%)

Adjust the color production on all color channels to make the printed output lighter 
or darker.

Check and Print
(Default is No)

This option is only available if your printer has an optional hard disk drive installed. 
Check and Print allows you to print a single copy of a multiple copy job that can be 
visually checked before printing additional copies. When the Check and Print copy 
has been printed, you can specify the number of additional copies of the job to print 
using the Check and Print screens at the printer’s operation panel. You can also use 
the Fiery WebSpooler to print remaining copies of spooled check and print jobs. 
This option is effective when the number of copies specified is greater than one.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: For Check and Print to take effect, the copy count must be greater than 1 and 
the Collate option for the application print dialog box should be turned Off.

CMYK Simulation 
SWOP-Coated/DIC/
Euroscale/None
(Default value is None)

CMYK simulation settings can be used to simulate popular offset printing press 
standards. Select SWOP to simulate printing to a standard American offset press; 
Euroscale to simulate a European offset press, or DIC to simulate a standard 
Japanese offset press. For more information see “CMYK Simulation” on page 1-19
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Color CRD Text 
Color CRD Graphics
Color CRD Images
None/Photographic/
Presentation/
Transparency (OHP)

Default values:
Text: Presentation
Graphics: Presentation
Images: Photographic

Before an RGB image can be printed, the file’s color data must be converted to the 
printer’s CMYK color space. Color rendering dictionaries apply optimal gamut 
mapping methods to documents that contain text, photographs and illustrations. 
The Photographic CRD optimizes the range of colors on the printer to produce the 
best results for photographic or bitmapped images. 
The Presentation CRD optimizes the output of pure, saturated colors such as those 
used in business presentations. 
The Transparency (OHP) CRD improves the correspondence between monitor 
colors and printed color on transparency paper.
For additional information regarding Color Rendering Dictionaries, see “Rendering 
styles” on page 1-18.

NOTE: Color rendering dictionaries cannot be used with CMYK files.

Color Mode
CMYK/Grayscale 
(Default value is CMYK)

By default your printer is set to print documents in color (CMYK). Select Grayscale 
to optionally print documents in grayscale.

Color Matching
ColorSync Color Matching
PostScript Color Matching
Black and White
Color/Grayscale

The Adobe PostScript 8.5.1 driver can convert RGB colors of a file to a specified 
CMYK device target using ICC technology. Choose this option to specify the use of 
an ICC device profile installed on your computer. 
For more information on rending styles, see “Color management on the Fiery 500” 
on page 1-16. For information on how to install and use the Fiery 500 ICC printer 
profile, see Getting Started.

Electronic Collation
(Default value is No)

This option is only available if your printer has an optional hard disk drive installed. 
Electronic Collation allows the pages of each copy of a print job to be printed in 
sequence. If this option is off, multiple copies of each page of a print job are printed 
in sequence. To avoid unexpected results, always select collation in the print driver 
and turn off any collation option that may exist in your application.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: The Collate option in the application print dialog box must be turned Off 
when selecting the Electronic Collation option from the printer driver.

Halftone Text
Halftone Graphics
Halftone Images
(Default is Detail for Text 
and Smooth for Graphics 
and Images)

This option determines which type of halftone screening is used for various 
elements in your print job. Use the Detail setting for printing of fine lines and 
details that are sometimes fuzzy or unclear. Use the Smooth setting for gradients or 
tones which blend together.

NOTE: When printing graphics with thin or fine lines, such as CAD data, you should 
select the Detail setting for Halftone Graphics.

Printer Specific Option: Description:
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Media Type
(Default value is Plain Paper)

Paper types supported by the printer can be specified by name: Plain Paper, 
Transparency, and Thick Paper. Choosing the correct media optimizes the fuser’s 
application of toner.

Paper Paper and envelope sizes supported by the printer can be specified by name. Paper 
options are located in the Page Setup dialog box.

Paper Source
(Default value is Auto Select)

Paper trays can be specified by name. Options include: Auto Select, Bypass Tray, 
Tray 1, Tray 2 and Tray 3. You can select Tray 2 or Tray 3 only if they are installed on 
your printer. Paper source options are located under the General menu of the Print 
dialog box.

RGB Source 
EFIRGB/sRGB (PC)/
Apple Standard/Off
(Default value is sRGB)

RGB source profiles allow you to define the color space characteristics (such as the 
white point, gamma and type of phosphors) of the image’s source. When a source is 
specified, the image’s RGB data can be optimally converted to the color space and 
gamut of the Fiery 500 printer.
The EFIRGB setting is optimal for color conversions that will be sent to the 
Fiery 500 printer. The sRGB (PC) setting specifies the source space of a generic 
Windows computer monitor. The Apple Standard setting specifies the source space 
of all standard Macintosh monitors.

NOTE: The RGB source setting overrides any source color space profile you may have 
specified using other color management systems. In cases where you don’t want this 
setting to override another specified source color space, choose Off.
For additional information regarding source profiles, see “RGB Source and 
Rendering Style” on page 1-17.

Printer Specific Option: Description:
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The following chapter describes where to set print options available using the 
PostScript printer driver if you are running Windows 95/98 or Windows NT 4.0 
operating systems. 

PostScript printing
Custom print options available from the PostScript printer driver are described in 
“Windows print options” on page 3-8. For additional information on using 
Fiery 500 color management options, see Chapter 1.

For information on installing the appropriate driver for your system and setting 
up the environment for parallel printing with the Fiery 500, see Getting Started. 
This manual also describes how to connect to the printer over the network, how 
to set up networking for all supported network types, and how to install 
additional Fiery 500 user software.

For information about achieving the best printing results from specific 
applications, see Chapter 5, “Application Notes.”

Configuring PostScript printing options with Windows 95/98 
This section describes configuring printing options for Windows 95/98 using the 
Adobe PostScript printer driver provided on the User Software CD. 

Print options are specified from the Printer properties dialog box. This dialog box 
can be accessed using the steps described below, or by selecting File>Print from 
within your application and clicking the Properties button to display the Printer 
Properties dialog box.

Chapter 3:
PostScript 
Printing from 
PC-Compatible 
Computers
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TO CONFIGURE POSTSCRIPT PRINTING OPTIONS:

1. From the Windows Start menu, choose Settings>Printers.

2. Click the Fiery 500-PS icon to select it and choose Properties from the File menu.

The Printer Properties dialog box appears, with the General tab displayed.

Set PostScript printing options from tabs in this dialog box.

3. Choose the Paper tab.

Specify print job options.
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4. Click the More Options button in the Paper tab.

Specify the type of media and page border setting for your print job.

5. Choose the Device Options tab and the Output tab. 

Specify the use of features related to optional devices installed on your printer.

6. Choose the Options tab in the Device Options tab. 
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Specify optional print devices installed on your printer.

7. To add an option, select a device option in the Available options list, and click 
Add. To remove an option, select a device option from the Installed options list 
and click Remove. Click OK. 

NOTE: Features related to optional devices, such as a paper tray or hard disk drive, 
are enabled in Windows printer drivers only when you have specified installed 
options in this tab.

8. Choose the Halftone tab in the Device Options tab.

Specify halftone settings for text, graphics, and images.
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9. Choose the ColorWise tab. 

Specify color control settings for your print job. For example, choose ColorWise 
Business Color to apply the default Color Rendering Dictionaries (CRDs) to 
Photos, Text, and Illustration objects in a document. 

Choose ColorWise Expert Mode to enable the application of Color Rendering 
Dictionaries (CRDs) of your choice to Photographic, Text, and Illustration 
objects in a document.

You can also choose ICM Profile to assign a specific profile to this print job or 
choose Grayscale to print this job in black and white.
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10. Choose the Watermarks tab. 

Use options in this tab to print a watermark on the copies of a print job. Supplied 
watermarks can also be edited from this tab.

Configuring PostScript printing options with Windows NT
This section describes configuring printing options for Windows NT 4.0 systems. 
On Windows NT 4.0, PostScript printing options are set from the Printer 
Properties dialog box and the Default Document Properties dialog box. 

TO CONFIGURE POSTSCRIPT PRINTING OPTIONS:

1. From the Windows NT 4.0 taskbar, click on Start, choose Settings, and then 
Printer. Right-click the Fiery 500-PS icon and choose Properties from the pull 
down menu.
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2. Click the Device Settings tab. 

All print options, including custom print options, can be set from tabs and scroll 
lists in this dialog.

NOTE: You can also set custom print options from the Default Document 
Properties dialog box. 

3. Right-click the Fiery 500 PostScript printer icon and choose Document Defaults 
from the pull down menu. 

The Document Defaults dialog appears. Note that when printing from 
applications this dialog appears when you choose Print, and click the Properties 
button in Print dialog box.
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4. To view options, double click an item. To change a setting, select an option, 
choose a setting from the submenu and click OK.

Windows print options
The printer drivers that come with your printer have been customized to provide 
additional print options specific to your Fiery 500 printer. These options have 
been integrated into the driver interface. Although the PCL and PostScript printer 
driver interfaces vary between Windows 98, Windows 95, and Windows NT 4.0 
operating systems, the printing features available from each driver, on each 
platform are the virtually the same. 



33-9 Windows print options
The following table describes custom print options available using the PostScript 
printer driver using Windows 95/98.

 Print option: Description:

Brightness 
85% to 115%
(Default value is 100%)

Adjust the color production on all color channels to make the printed output lighter 
or darker.

Check and Print
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Check and Print allows you to print a single copy of a multiple copy job that can be 
visually checked before printing additional copies. When the Check and Print copy 
has been printed, you can specify the number of additional copies of the job to print 
using the Check and Print screens at the printer’s operation panel. This option is 
effective when the number of copies specified is greater than one.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: For Check and Print to take effect, the copy count must be greater than 1 and 
the Collate option for the application print dialog box should be turned Off.

ColorWise Business Color
(Default values:
Text: Presentation
Graphics: Photographic
Images: Presentation)

Before an RGB image can be printed, the file’s color data must be converted to the 
printer’s CMYK color space. Color rendering dictionaries allow you to apply optimal 
gamut mapping methods for text, photographs and illustrations.
ColorWise Business Color specifies the application of the Photographic color 
rendering dictionary to photographic objects, and the Presentation color rendering 
dictionary to illustration and text objects in a document. Use this option if you are 
printing documents created in office applications that include color charts or mixed 
graphic and text elements. 
For additional information on Color Rendering Dictionaries, see “Rendering styles” 
on page 1-18.

NOTE: When ColorWise Business Color is selected CRD settings are disabled. Color 
rendering dictionaries cannot be used with CMYK files.

ColorWise Expert Mode ColorWise Expert Mode enables CRD settings.You may select any combination of 
these settings to customize the printing of text graphic and illustration objects in your 
documents. Use this option if you are printing documents with a natural range of 
colors as in a continuous tone photograph. 
For additional information on Color Rendering Dictionaries, see “Rendering styles” 
on page 1-18.

Device Options Optional printer accessories installed on your printer must be specified from the 
printer driver to enable their related features. Options include: Tray2, Tray 3, Disk.
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Electronic Collation
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Electronic Collation allows the pages of each copy of a print job to be printed in 
sequence. If this option is off, multiple copies of each page of a print job are printed in 
sequence.To avoid unexpected results, always select collation in the print driver and 
turn off any collation option that may exist in your application.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: The Collate option in the application print dialog box must be turned Off 
when selecting the Electronic Collation option from the printer driver. 

Grayscale By default your printer is set to print documents in color (CMYK). Select Grayscale 
to print documents in grayscale.
Note many applications offer black and white or grayscale printing options. Use the 
application’s grayscale option, if available, for more efficient processing time.

Halftone Text
Halftone Graphics
Halftone Images
(Default value is Detail for 
Text, Smooth for Graphics 
and Images)

This option determines which type of halftone screening is used for various elements 
in your print job. Use the Detail setting for printing of fine lines and details that are 
sometimes fuzzy or unclear. Use the Smooth setting for gradients or tones which 
blend together.

NOTE: When printing graphics with thin or fine lines, such as CAD data, you should 
select the Detail setting for Halftone Graphics.

Paper Size Paper and envelope sizes supported by the printer can be specified by name.

Paper Source Paper trays can be specified by name. Options include: Auto Select, Bypass Tray, 
Tray 1, Tray 2, and Tray 3. Tray 2 and Tray 3 can be specified only if they are installed 
on your printer. (See ‘Device Options’.) 

Paper Type Media types supported by the printer can be specified by name. Options include: 
Plain Paper, Transparency, and Thick Paper. Choosing the correct media optimizes the 
fuser’s application of toner.

 Print option: Description:
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The following table describes the custom print options available using the 
PostScript printer driver and Windows NT 4.0.

RGB Source 
EFIRGB/sRGB (PC)/
Apple Standard/Off 
(Default value is sRGB)

RGB source profiles allow you to define the color space characteristics (such as the 
white point, gamma and type of phosphors) of the image’s source. When a source is 
specified, the image’s RGB data can be optimally converted to the color space and 
gamut of the Fiery 500 printer.
The EFIRGB setting is optimal for color conversions that will be sent to the Fiery 500 
printer. The sRGB setting specifies the source space of a generic Windows computer 
monitor. The Apple Standard setting specifies the source space of all standard 
Macintosh monitors.

NOTE:  

• The RGB source setting overrides any source color space profile you may have 
specified using other color management systems. In cases where you don’t want 
this setting to override another specified source color space, select Off.
For additional information on source profiles, see “RGB Source and Rendering 
Style” on page 1-17.

• This option is visible only if you have selected ColorWise Expert Color.

Simulation 
SWOP-Coated/DIC/
Euroscale/None 
(Default value is None)

CMYK simulation settings adjust CMYK color data to simulate printing to an offset 
press standard. 
Select SWOP-Coated to simulate printing to a standard American offset press; 
Euroscale to simulate a European offset press, or DIC to simulate a standard Japanese 
offset press. For more information see “CMYK Simulation” on page 1-19.

NOTE: This option is visible only if you have selected ColorWise Expert Color.

Watermarks This option is available from the Windows 95/98 driver only. A watermark is message 
that can be printed on the pages of a document to convey additional information to 
the reader about its content. You can print a water mark on the first page of the print 
job, or all pages of the print job. The supplied watermarks can be edited, or you can 
create new watermarks for your documents. 

 Print option: Description:

Brightness 
85% to 115%
(Default value is 100%)

Adjust the color production on all color channels to make the printed output lighter 
or darker.

 Print option: Description:
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Check and Print
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Check and Print allows you to print a single copy of a multiple copy job that can be 
visually checked before printing additional copies. When the Check and Print copy 
has been printed, you can specify the number of additional copies of the job to print 
using the Check and Print screens at the printer’s operation panel. This option is 
effective when the number of copies specified is greater than one.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: For Check and Print to take effect, the copy count must be greater than 1 and 
the Collate option for the application print dialog box should be turned Off.

CMYK Simulation 
SWOP-Coated/DIC/
Euroscale/None 
(Default value is None)

CMYK simulation settings adjust CMYK color data to simulate printing to an offset 
press standard. 
Select SWOP-Coated to simulate printing to a standard American offset press; 
Euroscale to simulate a European offset press, or DIC to simulate a standard Japanese 
offset press. For more information see “CMYK Simulation” on page 1-19.

Collate
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Collate allows the pages of each copy of a print job to be printed in sequence. If this 
option is off, multiple copies of each page of a print job are printed in sequence.To 
avoid unexpected results, always select collation in the print driver and turn off any 
collation option that may exist in your application.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: The Collate option in the application print dialog box must be turned Off 
when selecting the Collate option from the printer driver. 

ColorCRD Text/Graphics/
Images
(Default values:
Text: Presentation
Graphics: Presentation
Images: Photographic)

Before an RGB image can be printed, the file’s color data must be converted to the 
printer’s CMYK color space. Color rendering dictionaries allow you to apply optimal 
gamut mapping methods for text, photographs and illustrations.
ColorCRD Images specifies the application of a color rendering dictionary to 
photographic objects. ColorCRD Graphics and ColorCRD Text specify the use of 
color rendering dictionaries with illustration and text objects in a document. Use the 
default settings if you are printing documents created in office applications that 
include color charts or mixed graphic and text elements. 
For additional information on Color Rendering Dictionaries, see “Rendering styles” 
on page 1-18.

 Print option: Description:



33-13 Windows print options
Color Mode By default your printer is set to print documents in color (CMYK). Select Grayscale 
to print documents in grayscale.
Note many applications offer black and white or grayscale printing options. Use the 
application’s grayscale option, if available, for more efficient processing time.

Halftone Text
Halftone Graphics
Halftone Images
(Default value is Detail for 
Text, Smooth for Graphics 
and Images)

This option determines which type of halftone screening is used for various elements 
in your print job. Use the Detail setting for printing of fine lines and details that are 
sometimes fuzzy or unclear. Use the Smooth setting for gradients or tones which 
blend together.

NOTE: When printing graphics with thin or fine lines, such as CAD data, you should 
select the Detail setting for Halftone Graphics.

Installable Options Optional printer accessories installed on your printer must be specified from the 
printer driver to enable their related features. Options include: Tray2, Tray 3, Disk.

Media 
(Default value is Plain 
Paper)

Media types supported by the printer can be specified by name. Options include: 
Plain Paper, Transparency, and Thick Paper. Choosing the correct media optimizes the 
fuser’s application of toner.

Paper Size Paper and envelope sizes supported by the printer can be specified by name.

Paper Source Paper trays can be specified by name. Options include: Auto Select, Bypass Tray, 
Tray 1, Tray 2, and Tray 3. Tray 2 and Tray 3 can be specified only if they are installed 
on your printer. (See ‘Device Options’.) 

RGB Source 
EFIRGB/sRGB (PC)/
Apple Standard/Off 
(Default value is sRGB)

RGB source profiles allow you to define the color space characteristics (such as the 
white point, gamma and type of phosphors) of the image’s source. When a source is 
specified, the image’s RGB data can be optimally converted to the color space and 
gamut of the Fiery 500 printer.
The EFIRGB setting is optimal for color conversions that will be sent to the Fiery 500 
printer. The sRGB setting specifies the source space of a generic Windows computer 
monitor. The Apple Standard setting specifies the source space of all standard 
Macintosh monitors.

NOTE: The RGB source setting overrides any source color space profile you may have 
specified using other color management systems. In cases where you don’t want this 
setting to override another specified source color space, select Off.
For additional information on source profiles, see “RGB Source and Rendering Style” 
on page 1-17.

 Print option: Description:
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The following chapter describes where to set print options available using the 
PCL printer driver if you are running Windows 95/98 or Windows NT 4.0 
operating systems. 

PCL printing
Custom print options available from the PCL and PostScript printer drivers are 
described in “Windows print options” on page 4-10.

For information on installing the appropriate driver for your system and setting 
up the environment for parallel printing with the Fiery 500 PCL, see Getting 
Started. This manual also describes how to connect to the printer over the 
network, how to set up networking for all supported network types and how to 
install additional Fiery 500 user software.

For information about achieving the best printing results from specific 
applications, see Chapter 5, “Application Notes.”

Configuring PCL printing options for Windows 95/98
This section describes configuring printing options for Windows 95/98 using the 
PCL printer driver. You can also specify custom print options for your print job 
by choosing File>Print from within an application. In the dialog box that appears, 
click Properties to display the Printer Properties dialog box. 

Chapter 4:
PCL Printing 
from 
PC-Compatible 
Computers
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TO CONFIGURE PRINTING OPTIONS FOR WINDOWS 95/98:

1. From the Windows Start menu, choose Settings>Printers.

2. Click the Fiery 500 PCL icon to select it and choose Properties from the File 
menu.

The Printer Properties dialog box appears, with the General tab displayed.

Set PCL printing options from tabs in this dialog box. 

3. Choose the Setup tab. 

Specify print job options.
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4. Choose the Device Options tab and the Output tab. 

Specify the type of media and use of features related to optional devices installed 
on your printer.

5. Choose the Options tab. 

Specify optional print devices installed on your printer.
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6. To add an option, select a device option in the Available options list, and click 
Add. To remove an option, select a device option from the Installed options list 
and click Remove. Click OK. 

NOTE: Features related to optional devices, such as a paper tray or hard disk drive, 
are enabled in Windows printer drivers only when you have specified installed 
options in this tab.

For more information about the Fiery 500 PCL printer driver, click the Help 
button.

7. Choose the ColorWise tab. 

Specify color control settings for your print job. For example, choose ColorWise 
Business Color to apply the default Color Rendering Dictionaries (CRDs) to 
Photos, Text, and Illustration objects in a document. 

Choose ColorWise Expert Mode to enable the application of Color Rendering 
Dictionaries (CRDs) of your choice to Photographic, Text, and Illustration 
objects in a document. 
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8. Choose the Watermarks tab. 

Use options in this tab to print a watermark on the copies of a print job. Supplied 
watermarks can also be edited from this tab.

NOTE: You cannot use a comma (,) in any watermark text.
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Configuring PCL printing options with Windows NT
This section describes configuring printing options for Windows NT 4.0 systems 
using the PCL printer driver provided on the User software CD. On Windows 
NT 4.0, PCL printing options are set from the Printer Properties dialog box and 
the Default Document Properties dialog box. 

TO CONFIGURE PCL PRINTING OPTIONS FOR WINDOWS NT:

1. From the Windows NT 4.0 taskbar, choose Settings and then Printers. Right-click 
the Fiery 500 PCL icon and choose Properties from the File menu.

The printer properties dialog appears. All print options, including custom print 
options, can be set from tabs in this dialog box.

Custom print options can also be set from the Default Document Properties 
dialog box, which includes options specific to the Fiery 500 printer.
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2. Right-click the Fiery 500 PCL printer icon, and choose Document Defaults from 
the File menu.

The Document Defaults dialog box appears. When printing from applications, 
this dialog box appears when you click the Properties button in the Print dialog 
box.

3. Choose the Device Options tab and the Output tab. 

Specify the type of media and use of features related to optional devices installed 
on your printer.



44-8 PCL Printing from PC-Compatible Computers
4. Choose the Options tab. 

Specify optional print devices installed on your printer.

5. To add an option, select a device option in the Available options list, and click 
Add. To remove an option, select a device option from the Installed options list 
and click Remove. Click OK. 

NOTE: Features related to optional devices, such as a paper tray or hard disk drive, 
are enabled in Windows printer drivers only when you have specified installed 
options in this tab.

For more information about the Fiery 500 PCL printer driver, click the Help 
button.
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6. Choose the ColorWise tab. 

Specify color control settings for your print job. For example, choose ColorWise 
Business Color to apply the default Color Rendering Dictionaries (CRDs) to 
Photos, Text, and Illustration objects in a document. 

Choose ColorWise Expert Mode to enable the application of Color Rendering 
Dictionaries (CRDs) of your choice to Photographic, Text, and Illustration 
objects in a document. 

7. Choose the Watermarks tab. 

Use options in this tab to print a watermark on the copies of a print job. Supplied 
watermarks can also be edited from this tab.
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NOTE: You cannot use a comma (,) in any watermark text.

Windows print options
The printer drivers that come with your printer have been customized to provide 
additional print options specific to your Fiery 500 printer. These options have 
been integrated into the driver interface. Although the PCL and PostScript printer 
driver interfaces vary between Windows 98, Windows 95, and Windows NT 4.0 
operating systems, the printing features available from each driver, on each 
platform are virtually the same. 

The following table describes custom print options available using the PCL 
printer driver using Windows 95/98 and Windows NT 4.0.

 Print option: Description:

Brightness 
85% to 115%
(Default is 100%)

Adjust the color production on all color channels to make the printed output lighter 
or darker.

Check and Print
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Check and Print allows you to print a single copy of a multiple copy job that can be 
visually checked before printing additional copies. When the Check and Print copy 
has been printed, you can specify the number of additional copies of the job to print 
using the Check and Print screens at the printer’s operation panel. This option is 
effective when the number of copies specified is greater than one.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: For Check and Print to take effect, the copy count must be greater than 1 and 
the Collate option for the application print dialog box should be turned Off.
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ColorWise Business Color
(Default values:
Text: Presentation
Graphics: Photographic
Images: Presentation)

Before an RGB image can be printed, the file’s color data must be converted to the 
printer’s CMYK color space. Color rendering dictionaries allow you to apply optimal 
gamut mapping methods for text, photographs and illustrations.
ColorWise Business Color specifies the application of the Photographic color 
rendering dictionary to photographic objects, and the Presentation color rendering 
dictionary to illustration and text objects in a document. Use this option if you are 
printing documents created in office applications that include color charts or mixed 
graphic and text elements. 
For additional information on Color Rendering Dictionaries, see “Rendering styles” 
on page 1-18.

NOTE: When ColorWise Business Color is selected CRD settings are disabled. Color 
rendering dictionaries cannot be used with CMYK files. This option is available only 
if your printer has a hard disk drive installed.

ColorWise Expert Mode ColorWise Expert Mode enables CRD settings.You may select any combination of 
these settings to customize the printing of text graphic and illustration objects in your 
documents. Use this option if you are printing documents with a natural range of 
colors as in a continuous tone photograph. 
For additional information on Color Rendering Dictionaries, see “Rendering styles” 
on page 1-18.

Device Options Optional printer accessories installed on your printer must be specified from the 
printer driver to enable their related features. Options include: Tray 2, Tray 3, Disk.

Electronic Collation
(Default is No)

This option is available only if your printer has an optional hard disk drive installed. 
Electronic Collation allows the pages of each copy of a print job to be printed in 
sequence. If this option is off, multiple copies of each page of a print job are printed in 
sequence. To avoid unexpected results, always select collation in the print driver and 
turn off any collation option that may exist in your application.

NOTE: This option is available only if your printer has an optional hard disk 
drive installed.

NOTE: The Collate option in the application print dialog box must be turned Off 
when selecting the Electronic Collation option from the printer driver. 

Grayscale By default your printer is set to print documents in color (CMYK). Select Grayscale 
to print documents in grayscale.
Note many applications offer black and white or grayscale printing options. Use the 
application’s grayscale option, if available, for more efficient processing time.

 Print option: Description:
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Media Type
(Default value is Plain 
Paper)

Paper types supported by the printer can be specified by name: Plain Paper, 
Transparency, and Thick Paper. Choosing the correct media optimizes the fuser’s 
application of toner.

Paper Size Paper and envelope sizes supported by the printer can be specified by name. 

Paper Tray Paper trays can be specified by name. Options include: Auto Select, Bypass Tray, 
Tray 1, Tray 2, and Tray 3. Tray 2 and Tray 3 can be specified only if they are installed 
on your printer. (See ‘Devices Options’.) 

Watermarks A watermark is message that can be printed on the pages of a document to convey 
additional information to the reader about its content. You can print a water mark on 
the first page of the print job, or all pages of the print job. The supplied watermarks 
can be edited, or you can create new watermarks for your documents. 

 Print option: Description:
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This chapter provides instructions for printing color documents from QuickDraw 
and GDI applications such as presentation, spreadsheet, and word processing 
applications and from PostScript applications such as illustration and page layout 
applications.

NOTE: These notes are applicable if you are printing using PostScript or PCL 
printer drivers.

Working with office applications
The Fiery 500 color management system provides complete color management 
for jobs printed from office applications. Before printing from these applications, 
make sure the appropriate printer driver is installed on your computer as 
described in Getting Started.

Office applications 
Printers such as the Fiery 500 must receive PostScript or PCL instructions to print 
an image or a document. Many applications do not create these instructions by 
themselves, and instead rely on the printer driver to create them. Included in this 
category are most word processors, spreadsheets, and presentation packages. These 
applications use Apple QuickDraw to display and print when running on 
Macintosh computers; they use the Windows Graphics Device Interface (GDI) 
to display and print when running under Windows. We refer to these QuickDraw 
and GDI applications as “office applications.”

All office applications handle color similarly, using the same RGB color model 
used for the color monitor display. Most office applications allow you to choose 
colors from a palette of preselected colors; some allow you to add new colors to 
the palette using a color picker. Although some applications allow you to specify 
color using the CMY, HSL, and HSB color models, these applications always send 
RGB color data to the Fiery 500. (An exception to this is a CMYK EPS file placed 
in the document, which is sent as CMYK data.)

Chapter 5:
Application 
Notes
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When working with color in office applications, keep in mind that:

• The range of colors that can be displayed in RGB on your monitor is much 
larger than the range of colors that can be printed on your print device. When 
you print the document, out-of-gamut RGB colors are mapped to colors your 
print device can produce.

• These applications send only RGB data to the Fiery 500. You control the 
rendering intent of the color conversion with your selection of a CRD.

Each CRD uses a different color rendering style, and therefore has a different way 
of mapping unprintable colors to your print device’s color gamut. Fiery 500 color 
rendering styles are described on page 1-18. 

Working with imported files
Use EPS format files for all raster images you import into office applications. They 
print at their full resolution on the Fiery 500 (not at the low resolution used for 
the screen preview). 

Although your application may allow you to import a variety of file formats, EPS 
format files are recommended for all raster images you want to import; some 
applications have printing problems when using file formats such as TIFF and 
PICT. For more information regarding raster images see “Raster images and vector 
images” on page 1-12.

All RGB images placed in your document are affected by your RGB Source and 
Rendering Style settings. 

Tip for advanced users

If you place multiple RGB images, some non-photographic and some 
photographic, a single CRD may not be suitable for all the images. In this case 
you may want the photographic images to bypass the CRD altogether. To 
accomplish this, separate the image to CMYK data with a pixel-editing 
application such as Photoshop and perform color correction on it. Then save it as 
an EPS file and import it into the document. When specifying print option 
settings, set the CMYK Simulation option to None so that the Rendering Style 
setting will not be applied to CMYK data (see “Rendering styles” on page 1-18).
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Selecting options when printing
There are few differences between office applications with regard to Fiery 500 
printing. The instructions in this chapter apply to all office applications. Use the 
instructions in “Color management on the Fiery 500” on page 1-16 to specify 
print options and color management settings. To specify these options, you must 
use a Fiery 500 PostScript or PCL printer driver.

Because these applications send RGB data to the Fiery 500, your choices of 
RGB Source and Rendering Style settings are important. Be sure to specify the 
appropriate CRD for the color effect you want (see “Rendering styles” on 
page 1-18).

Microsoft Office 97
Before printing from Microsoft Office 97 on Windows 95/98, make sure the 
Fiery 500 ICM profile is not installed in the Windows\System\Color folder. If the 
ICM profile is installed, JPEG, BMP, and TIFF images print incorrectly from 
Microsoft Office 97.

Browse to the Windows\System\Color folder and locate the Fiery 500 ICM 
profile. If the icon is white, the profile is installed; if it is gray, it is not installed. If 
the profile is installed, select the profile and choose the right-mouse Uninstall 
command. 

NOTE: The standard format for digital color management systems developed by 
the Image Color Consortium (ICC) is implemented in Image Color Matching 
(ICM) on Windows 95/98 computers and in ColorSync on Mac OS computers. 
The term “ICM profile” is used to refer to the ICC-standard device profile 
provided for Windows 95/98 computers.

Working with Photoshop 5.0
This following sections cover features of Photoshop version 5.0 for Macintosh and 
Windows. The illustrations show only Macintosh-version dialog boxes, but the 
information and instructions apply equally to the Windows version of Photoshop.
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Before you begin
Because Photoshop 5.0 uses a sophisticated color management system, there are 
several setup steps you should take before you begin working. These steps include 
calibrating your monitor, adjusting Photoshop 5.0 color settings, and setting 
ColorSync defaults (Mac OS only).

For information on monitor calibration, see your Adobe Photoshop 5.0 
documentation.

Photoshop 5.0 settings
Photoshop 5.0 has three setup dialogs which control how color is managed when 
opening and saving RGB and CMYK images. Profile Setup, RGB Setup, and 
CMYK Setup should all be completed before you begin working in Photoshop.

Profile Setup

From the Photoshop 5.0 File menu, select Color Settings>Profile Setup.

In the Embed Profiles area, check all boxes. This will embed the appropriate 
profile when saving a file. Photoshop will then know for which specific device the 
file has been designed, tagging your file as device specific.
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In the Assumed Profiles area, select Ask When Opening for RGB and CMYK. 
When opening files that do not contain an ICC profile, you will have the choice 
to convert the file to your current Photoshop working space setting or leave the 
file unconverted. The latter is usually preferred, but you should make sure that the 
current Photoshop working space setting matches the intended color space of the 
image.

In the Profile Mismatch Handling area, select Ask When Opening for RGB and 
CMYK. When opening a file that contains an ICC profile that does not match 
your current Photoshop working space setting, you will have the choice to convert 
from the embedded profile or not convert. If you want to preserve the full gamut 
of the image source, choose not to convert. If your working space is set to your 
output device, you may want to convert.

RGB Setup

Photoshop 5.0 allows you to simultaneously use two RGB spaces, one for the 
monitor and one for the Photoshop RGB working space. The monitor RGB space 
setting does not affect the image data in the file; it only affects the way the image 
is displayed on the monitor. Even if an RGB image has been prepared with 
different monitor settings, it will still be correctly displayed on your monitor, 
without changes to the original values in the file.

From the Photoshop 5.0 File menu, select Color Settings>RGB Setup.

From the RGB pop-up menu, select your current Photoshop RGB color space. 
This should reflect the color space of the RGB files you will be opening. If you 
create new RGB files, or if you want to standardize your RGB files, select 
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EFIRGB. Click Load if the file is not visible in the RGB pop-up menu. You can 
load the Calibrated RGB setup file, EFIRGB ICC ColorSync file, or the 
EFIRGB.ICM file. All describe the same RGB space and automatically set the 
Gamma, White Point, and Primaries. sRGB may be considered if you are using 
non-professional color software on a PC and you rely on a Windows operating 
system to manage the color of your monitor. You will then get more consistent 
results as long as you also print with the RGB Source option set to sRGB.

The Monitor area shows the currently selected profile in the ColorSync Control 
Panel. Turn on the Display Using Monitor Compensation and Preview options.

CMYK Setup

From the Photoshop 5.0 File menu, select Color Settings>CMYK Setup.

For CMYK Model, select ICC. Previous versions of Photoshop used Photoshop 
Separation Tables, and these can be loaded for Photoshop 5.0. However, you will 
get better results using ICC profiles and the built-in color management system.

In the ICC Options area, select Profile, Engine, and Intent settings. For Profile, 
select your final output printer ICC profile. Pre-press users will select an ICC 
describing their target press (i.e. SWOP). A variety of press ICC profiles are 
available at http://www.colorsync.com. Office users should select the ICC profile 
describing the copier connected to the Fiery 500. In this case, you should avoid 
converting RGB to CMYK in Photoshop. Instead, leave images in RGB and allow 
the Fiery 500 to convert them to CMYK. 

For Engine, select Built-in. This indicates that the Photoshop engine will be used 
which is highly recommended for normal Photoshop usage.
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For Intent, select Perceptual (Images). This is appropriate for photographs which 
are normally edited in Photoshop. If you are creating synthetic colors, you may 
want to use Colormetric or Saturation.

Black Point Compensation should be unchecked for richer, denser CMY blacks. 
Preview should be checked.

ColorSync defaults
You should have ColorSync 2.5 installed on your Mac OS computer. The ICC 
profiles used by ColorSync are saved in System Folder:ColorSync Profiles. Under 
the Apple menu, select Control Panel>ColorSync. Use the following settings:

• System Profile—select the customized ICC profile for your monitor

• RGB default—select the same RBG working color space that you set in 
Photoshop 5.0

• CMYK default—select the same CMYK working color space that you set in 
Photoshop 5.0

• Preferred CMM—select LinoColor CMM (both ColorSync 2.0 and Microsoft 
ICM 2.0 are based on this color management module)

Defining colors
You can choose colors in Photoshop with various color models including HSB, 
Lab, RGB, and CMYK. You can also choose named colors from the PANTONE 
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Coated color library in Photoshop. For best results, use the color definition 
methods described in Chapter 1.

Saving files for importing into other documents
Before saving any file, perform any rotating, cropping, and resizing needed. This 
speeds processing when printing from the application in which the image is 
placed.

It is recommended that you use the EPS or TIFF file formats to save RGB images 
that will be imported into other documents and printed to the Fiery 500. EPS and 
TIFF files can be imported into virtually all page layout applications.

In the EPS Format dialog box, choose binary encoding and do not include transfer 
functions, halftone screens, or PostScript Color Management. A TIFF preview is 
compatible with both Mac OS and Windows computers.

If you experience problems printing the document in which you place the image, 
substitute an ASCII-encoded version of the same image, and print the document 
again. Binary encoding is much more compact than ASCII encoding, but 
occasionally causes printing problems with some system configurations.

Choose Photoshop EPS or 
TIFF
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NOTE: If you choose to try JPEG encoding, keep a backup of the original image 
saved with binary encoding until you have seen the printed results of the JPEG-
encoded file. The compression used for JPEG encoding may produce unwanted 
artifacts in the file. If you see unexpected results in the printed output of a JPEG-
encoded file, use a binary-encoded version instead.

Selecting options when printing
You can print RGB or CMYK images from Photoshop. 

• When you print RGB images, you can choose whether the conversion to 
CMYK data is performed by the Fiery 500 (using a CRD) or by Photoshop 
(using PostScript Color Management).

• When you print CMYK images, you can print composites or color 
separations.

Printing RGB images

Use the following instructions to print RGB images. 

Choose a color space and whether to use PostScript Color Management. (With 
the AdobePS 8.5.1 printer driver for Mac OS, these options appear in the Adobe 
Photoshop pane of the Print dialog box.) 

Click to print using the 
PostScript color management 
system
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NOTE: Only PostScript Level 3 printers support PostScript Color Management. If 
you select this option, the PostScript Color Management system will perform any 
color space conversion specified in the Space option before the image is sent to the 
Fiery 500. 

If you select an RGB color space, Photoshop sends RGB data to the Fiery 500 and 
a CRD is used to perform color conversion. Choose the appropriate print option 
settings for RGB data. (For information on print options, see Chapter 2 if you use 
a Macintosh; Chapters 3 and 4 if you use a PC.)

If you select a CMYK color space, Photoshop performs a color conversion and 
sends CMYK data to the Fiery 500. With this setting, RGB Source and Rendering 
Style settings have no effect.

• If Photoshop is configured for separating to an offset press standard, apply the 
corresponding CMYK Simulation setting. For example, if Photoshop is 
configured for separating to SWOP, choose SWOP-Coated as the CMYK 
setting.

• If Photoshop is configured for a custom separation (not a press standard), 
choose None as the CMYK Simulation setting or choose the corresponding 
custom simulation target if one has been created.

For fastest print times, select JPEG encoding. You should, however, check the 
printed output carefully for unwanted artifacts that can appear as a result of JPEG 
compression. If you see unexpected results in the printed output when printing 
with JPEG encoding, print the job again using Binary encoding.

Choose any other print options you want to use. (For information on print 
options, see Chapter 2 if you use a Macintosh; Chapters 3 and 4 if you use a PC.) 
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Printing CMYK images

Use the following instructions to print CMYK images. 

Choose an encoding method. (With the AdobePS 8.5.1 printer driver for 
Mac OS, these options appear in the Adobe Photoshop pane of the Print dialog 
box.) For fastest print times, select JPEG encoding. You should, however, check 
the printed output carefully for unwanted artifacts that can appear as a result of 
JPEG compression. If you see unexpected results in the printed output when 
printing with JPEG encoding, print the job again using Binary encoding.

Choose a color space and whether to use PostScript Color Management. 

Choose any other print options you want to use. RGB Source and Rendering 
Style settings have no effect on CMYK images. (For information on print options, 
see Chapter 2 if you use a Macintosh; Chapters 3 and 4 if you use a PC.)

• If the image was separated for an offset press standard, apply the corresponding 
CMYK Simulation setting. For example, if the image is separated for SWOP, 
choose SWOP-Coated as the CMYK Simulation setting. 

• If the image was separated using a custom separation (not a press standard), 
choose None as the CMYK Simulation setting or choose the corresponding 
custom simulation target if one has been created.
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Working with page layout applications
This section provides instructions for printing color documents from Adobe 
PageMaker 6.5 and QuarkXPress 3.32. 

Before printing from these applications, make sure the appropriate printer driver 
and the Fiery 500 PPD are installed on your computer as described in Getting 
Started. 

Defining colors
Page layout applications generally use the CMYK color model. Some allow you to 
define colors with other color models and may be able to send that data to the 
Fiery 500 in those other color models. For predictable results, use the CMYK 
Color Reference page when defining colors in page layout applications. See 
“Using the CMYK color reference page” on page 5-30. 

Importing images
EPS and TIFF are the recommended formats for images imported into page 
layout documents. Support for importing other file formats may be provided by 
individual applications. 

All RGB images placed in your document are affected by the RGB Source and 
Rendering Style settings. The Fiery 500 color management system applies the 
specified RGB Source setting to all RGB data and then uses the specified 
Rendering Style (CRD) to perform a color conversion. An exception to this 
occurs if you assign ICC profiles to RGB images using the application’s color 
management tools (see “Tips for advanced users” on page 5-12). In this case, the 
application performs the color conversion of the image and sends CMYK data to 
the Fiery 500.

Tips for advanced users

If you place multiple RGB images, some non-photographic and some 
photographic, a single CRD may not be suitable for all the images. In this case 
you may want the photographic images to bypass the CRD altogether. To 
accomplish this, separate the image to CMYK data with a pixel-editing 
application such as Photoshop and perform color correction on it. Then save it as 
an EPS or TIFF file and import it into the document. When specifying print 
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option settings, set the CMYK Simulation option to None so that the Rendering 
Style setting will not be applied to CMYK data (see “CMYK Simulation setting” 
on page 5-30).

Alternatively, you can save the RGB image in TIFF format and assign it an ICC 
profile and rendering intent when you import it into the document, if your 
application supports this feature.

CMYK Simulation
You can specify a press simulation target for the job with a print option (see 
“CMYK Simulation setting” on page 5-30). The CMYK Simulation setting 
affects all CMYK color data sent by the page layout application. 

• If the document contains CMYK images that were separated for an offset press 
standard, apply the corresponding CMYK Simulation setting. For example, for 
images separated for SWOP-Coated, choose SWOP-Coated as the CMYK 
Simulation setting. 

• If the document contains CMYK images that were separated for a custom 
separation (not a press standard), choose None as the CMYK Simulation 
setting.

Adobe PageMaker 6.5 for Macintosh and Windows
The Windows and Macintosh versions of PageMaker 6.5 are similar. The 
illustrations in this section show only the Windows version, with the exception of 
instances where differences exist between the two versions.

PostScript Level 2 interface

PostScript Level 2 features, including color management, are incorporated into 
the PageMaker 6.5 application interface. When you print from PageMaker 6.5, 
you specify print options and color settings using PageMaker print dialog boxes. 
However, you must use a PostScript Level 2 (or higher) printer driver to access 
Fiery 500 print options when printing from PageMaker.
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Windows version requirement

For the Windows version of PageMaker 6.5, make sure a copy of the Fiery 500 
PPD file is in both of the following folders:

PM65\RSRC\USENGLSH\PPD4
Windows\System

Importing images

All RGB images placed in your document are affected by your RGB Source and 
Rendering Style settings. For best results with placed images, use the instructions 
in “Importing images” on page 5-12 and “CMYK Simulation” on page 5-13.

Advanced users can use PageMaker’s color management tools for added flexibility 
with placed RGB images (see “Assigning ICC profiles to RGB images” on 
page 5-16). 

Selecting options when printing

All print settings are specified from the various Print dialog boxes in 
PageMaker 6.5. The printer driver interface is not used.

In the Print Document dialog box, select the Fiery 500 PPD from the PPD menu.

Choose the Fiery 500 PPD

Click Options

Fiery 500 appears here
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In the Print Options dialog box, choose Normal (not the Optimized Subsampling 
default) from the Send image data menu. This setting ensures that TIFF images 
print at their full resolution.

If your document contains RGB placed images or colors defined in RGB that will 
not be separated to process colors, choose RGB Source and Rendering Style 
settings in the Print Features dialog box. Choose any other Fiery 500 print 
options you wish.

When you click Print from any of the PageMaker 6.5 dialog boxes the job is sent 
to the Fiery 500. 

Choose Normal

Click Features
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Assigning ICC profiles to RGB images

When you place a non-EPS RGB image (such as a TIFF, JPEG, or GIF image), 
you can specify an ICC target profile and a rendering intent for the image. You 
can assign a unique rendering intent to each image you import.

When you use this feature, PageMaker controls the color conversion of the RGB 
images (using the specified ICC profiles) and sends CMYK data to the Fiery 500. 
The CMYK data produced by these conversions is not separated for offset press 
standards; therefore you should set the CMYK Simulation print option to None 
(see “CMYK Simulation” on page 5-13). The RGB Source and Rendering Style 
settings have no effect on these images (unless you specify a CMYK Simulation 
setting other than None).

After selecting an image to import with the Place command, the CMS Source 
button becomes active in the Place dialog box.

Click to select an ICC profile
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Click CMS Source and choose settings in the CMS Source Profile dialog box.

With the Macintosh version of PageMaker, choose ColorSync from the This Item 
Uses menu; with the Windows version, choose Kodak ICC.

The rendering intents correspond to Fiery 500 CRDs as follows:

• Image—similar to the Photographic CRD.

• Graphics—similar to the Presentation CRD.

• Colormetric—no corresponding CRD in the printer driver; best used for spot 
colors such as PANTONE colors.

The Default setting uses the profile’s rendering intent.

Windows

Choose a rendering intent

Choose Kodak ICC
Choose a source profile

Choose a rendering intent

Macintosh

Choose ColorSync
Choose a source profile
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You can also display this dialog box by selecting the image and choosing 
Image>CMS Source from the Element menu.

QuarkXPress 3.32 for Macintosh and Windows
Before starting QuarkXPress, make sure the EfiColor XTension is not loaded in 
the XTensions folder. EFICOLOR profiles are not currently provided with 
Fiery 500 printers. Without the correct EFICOLOR profile, the EfiColor 
XTension does not perform color conversions on placed images.

Windows version requirement

For the Windows version of QuarkXPress, make sure a copy of the Fiery 500 PPD 
file is in the XPRESS\PDF folder. 

Importing images

All RGB images placed in your document are affected by your RGB Source and 
Rendering Style settings. For best results with placed images, see “Rendering 
styles” on page 1-18. 

Selecting options when printing

You must select the Fiery 500 PPD from the Printer Type menu in the Page Setup 
(Macintosh) or Printer Setup (Windows) dialog box.

Choose the Fiery 500 PPD

Macintosh

Choose an output paper size 

Choose Binary
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If your document contains RGB placed images or colors defined in RGB that will 
not be separated to process colors, choose RGB Source and Rendering Style 
settings. Choose any other Fiery 500 print options you wish.

Working with illustration applications
This section provides instructions for using Illustrator 7.0 for Macintosh and 
Windows, FreeHand 7.0 for Macintosh and Windows, and CorelDRAW 7.0 for 
Windows. 

Before printing from these applications, make sure the PostScript and/or PCL 
printer driver is installed on your computer as described in Getting Started. 

You can print directly from an illustration application or use it to create and save 
files that will be imported into a page layout document.

NOTE: These application notes provide instructions for printing composites only. 
For instructions on printing color separations, refer to the documentation for your 
application.

Choose Fiery 500 PPD

Choose an output
paper size

Choose Binary

Windows
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As a general rule, use the EPS file format when saving files from an illustration 
application.

Defining colors
All illustration applications use the CMYK color model. While some also allow 
you to define colors using other color models, they all send CMYK data to the 
Fiery 500. For predictable results, use the CMYK Color Reference page when 
defining colors. See “Choosing colors in PostScript applications” on page 5-29.

Importing images
In general, all images placed into illustration application documents should be in 
EPS format. 

All RGB images placed in your document are affected by the RGB Source and 
Rendering Style settings. The Fiery 500 color management system applies the 
specified RGB Source setting to all RGB data and then uses the specified 
Rendering Style (CRD) to perform a color conversion. An exception to this 
occurs if you assign ICC profiles to RGB images using the application’s color 
management tools (see “Tips for advanced users”). In this case, the application 
performs the color conversion of the image and sends CMYK data to the 
Fiery 500.

If you apply any CMYK Simulation setting other than None to the job, CMYK 
data is also affected by the specified Rendering Style setting (“Rendering styles” on 
page 1-18).

Tips for advanced users

If you place multiple RGB images, some non-photographic and some 
photographic, a single CRD may not be suitable for all the images. In this case 
you may want the photographic images to bypass the CRD altogether. To 
accomplish this, separate the image to CMYK data with a pixel-editing 
application such as Photoshop and perform color correction on it. Then save it as 
an EPS or TIFF file and import it into the document. When specifying print 
option settings, set the CMYK Simulation option to None so that the Rendering 
Style setting will not be applied to CMYK data.
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Alternatively, you can save the RGB image in TIFF format and assign it an ICC 
profile and rendering intent when you import it into the document (see the 
individual application notes in this chapter).

CMYK Simulation
You can specify a press simulation target for the job with the print option: 
“CMYK Simulation”. The CMYK Simulation setting affects all CMYK color data 
sent by the illustration application. For information on CMYK Simulation 
settings, see “CMYK Simulation setting” on page 5-30.

• If the document contains CMYK images that were separated for an offset press 
standard, apply the corresponding CMYK Simulation setting. For example, for 
images separated for SWOP-Coated, choose SWOP-Coated as the CMYK 
Simulation setting.

• If the document contains CMYK images that were separated for a custom 
separation (not a press standard), choose None as the CMYK Simulation 
setting.

CorelDRAW 7.0 for Windows

Defining colors

Any colors defined in CorelDRAW are sent to the printer in CMYK—even those 
defined using other color models. For best results, use the color definition 
methods described in “Choosing colors in PostScript applications” on page 5-29.

You can control the conversion of RGB colors defined in CorelDRAW by 
specifying settings with the Color Manager (page 5-23). 

Importing images

All RGB images placed in your document are affected by your RGB Source and 
Rendering Style settings. For best results with placed images, use the instructions 
on page 5-20. 

Advanced users can use CorelDRAW’s color management tools for added 
flexibility with placed RGB images (see page 5-23). 
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Selecting options when printing

In the Print dialog box, make sure the correct printer and PPD are selected. 

To use Fiery 500 color management, make sure the “Use color profile” option is 
not turned on. If this option is turned on, CorelDRAW’s color management 
settings are used to convert RGB colors and images to CMYK (see page 5-23).

Click Properties to specify Fiery 500 print options.

Saving files for importing into other documents

When saving files in CorelDRAW for importing into other types of documents, 
use the EPS file format.

CorelDRAW saves all color information in CMYK, so CRDs have no effect on 
color output of artwork saved with CorelDRAW and imported into other kinds of 
documents. In the case of CorelDRAW files imported into Photoshop, however, 
vector data from the CorelDRAW file is rasterized into bitmaps in Photoshop, and 
the final color space of the bitmap data is determined by the color mode you set in 
Photoshop.

Printer name appears here 

Printer driver/PPD name 
appears here 

Click to access
Fiery 500 print

options

Turn off to use Fiery 500 
color management
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For advanced users—CorelDRAW color management

If the document contains RGB images or colors defined in RGB, you can use the 
CorelDRAW Color Manager to specify ICC profiles. 

In the Color Manager dialog box, select ICC profiles from the four menus. Refer 
to your CorelDRAW 7.0 documentation for instructions on setting the options in 
this dialog box. These settings affect only RGB images and colors defined in 
RGB—they have no effect on RGB EPS images.

Choose a printer
profile

Choose a source
profile
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In the Print dialog box, turn on the “Use color profile” option. The printer profile 
you selected appears to the right of this checkbox. 

Adobe Illustrator 7.0 for Macintosh and Windows
The Windows and Macintosh versions of Illustrator 7.0 are similar. The 
illustrations in this section show only the Macintosh version, with the exception 
of instances where differences exist between the two versions.

Defining colors

Any colors defined in Illustrator are sent to the printer in CMYK—even those 
defined using other color models. For best results, use the color definition 
methods described on “Choosing colors in PostScript applications” on page 5-29. 

Color Settings

You can control the conversion of RGB colors defined in Illustrator by specifying 
settings in the Color Settings dialog box. 

With Macintosh computers, you can specify the EFIRGB ICC profile as the 
Monitor profile. This defines the same source color space for RGB data defined in 
Illustrator as is defined by the Fiery 500 RGB Source setting of EFIRGB (see 
page 1-17). 

Turn on to use 
CorelDRAW’s color 
management
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If the “Use ICC profiles with TIFF” option is checked, you can specify an ICC 
profile and a rendering intent for each RGB TIFF image you place in the 
document (see “For advanced users—Illustrator color management” on 
page 5-28).

Importing images

All RGB images placed in your document are affected by your RGB Source and 
Rendering Style settings. For best results with placed images, use the instructions 
in “Importing images” on page 5-20 and “CMYK Simulation” on page 5-21.

Advanced users can use Illustrator’s color management tools for added flexibility 
with placed RGB images (see “For advanced users—Illustrator color 
management” on page 5-28). 

Choose a printer profile

Macintosh

Choose a rendering intent

Choose an ICC profile

For placed RGB TIFF 
images
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Selecting options when printing

Choose Composite output and, if you are using the PostScript printer driver, 
PostScript Level 2. 

Choose Composite Choose PostScript
Level 2

Macintosh

Windows

Choose Composite

Choose PostScript Level 2
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If your document contains placed RGB images, choose RGB Source and 
Rendering Style settings. With the exception of placed RGB images, these settings 
have no effect on colors printed with Illustrator 7.0 (unless you specify a CMYK 
Simulation setting other than None).

The PostScript Color Matching setting (made from the Macintosh printer driver) 
has no effect on colors printed from Illustrator 7.0. The effect of CRDs on placed 
RGB images is independent of this setting.

For information on print options, see Chapter 2 if you use a Macintosh; Chapters 
3 and 4 if you use a PC. 

Saving files for importing into other documents

When saving files in Illustrator 7.0 for importing into other types of documents, 
use the EPS file format.

Illustrator saves all color information in CMYK, so RGB Source and Rendering 
Style settings have no effect on color output of artwork saved with Illustrator and 
imported into other kinds of documents. (An exception occurs if you apply a 
CMYK Simulation setting other than None to the CMYK data; see “For advanced 
users—Illustrator color management” on page 5-28.) In the case of Illustrator files 
imported into Photoshop, however, vector data from the Illustrator file is 
rasterized into bitmaps in Photoshop, and the final color space of the bitmap data 
is determined by the color mode you set in Photoshop.
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For advanced users—Illustrator color management

When you place an RGB TIFF image, you can specify an ICC profile and a 
rendering intent for the image. You can assign a unique rendering intent to each 
image you import. To use this feature, make sure the “Use ICC profiles with 
TIFF” option is checked in the Color Settings dialog box. (See page 5-24)

Choose an ICC profile

Macintosh

Choose a rendering intent

Choose an ICC profile

Choose a rendering intent

Windows
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The rendering intents correspond to Fiery 500 CRDs as follows:

• Image—similar to the Photographic CRD.

• Graphics—similar to the Presentation CRD.

• Colorimetric—no corresponding CRD in the printer driver; best used for spot 
colors such as PANTONE colors.

The Default setting uses the profile’s rendering intent.

For more information on Illustrator’s color management features, see your 
Illustrator documentation.

Choosing colors in PostScript applications
With PostScript applications, you can create colors using any of the color models 
supported by the application. All PostScript applications support the CMYK 
model; some also support the RGB model and other color models based on 
monitor display values. PostScript applications also allow you to choose named 
colors using one or more color libraries, such as PANTONE.

The important thing to remember when creating or choosing colors is that the 
displayed versions of those colors may not match Fiery 500 output or the output 
of identically defined colors from other color print devices. For this reason, you 
should use color matching to ensure predictable color printing results with the 
Fiery 500. 

Color Reference files
Two color reference files have been included on the User Software CD, a CMYK 
and a PANONE color reference file.

Insert the User Software CD into your CD-ROM drive and use the installer’s 
Custom option to select the reference files to copy to disk. You can also navigate to 
the Color Reference (Macintosh) or Clrfiles (Windows) directory, and manually 
copy the files to your hard disk. 
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Using the CMYK color reference page

The CMYK color reference pages let you see how various cyan, magenta, yellow, 
and black combinations look when printed on your particular printer. The 
CMYK color reference file is an 11-page, letter- or A4-size PostScript file.

To print the CMYK pages, download the file using WebDownloader (Windows) 
or Adobe Downloader (Macintosh). (For instructions on using WebDownloader, 
see Chapter 7.) The printed pages display groups of color patches in graduated 
combinations of yellow, magenta, and cyan, and smaller patches that include 25, 
50, and 75% black. Refer to these pages to pick colors and specify process color 
values in your application. 

Using the PANTONE color reference pages

The PANTONE color reference pages let you see how the PANTONE named 
color patches look when printed on your particular printer. The PANTONE color 
reference file is a 19-page, letter- or A4-size PostScript file.

To print the PANTONE pages, download the file using WebDownloader 
(Windows) or Adobe Downloader (Macintosh). (For instructions on using 
WebDownloader, see Chapter 7.)

CMYK Simulation setting
If you are using the Fiery 500 to print proofs for an offset press job or to simulate 
another print device, choose the appropriate CMYK Simulation setting. The 
CMYK Simulation setting specifies the offset press standard that you want to 
simulate.

The CMYK Simulation setting you should specify depends on the press standard 
for which the CMYK data was separated. For example, for images that were 
separated for SWOP-Coated paper, choose SWOP-Coated as the CMYK 
Simulation setting. Select SWOP-Coated to simulate printing to a standard 
American offset press, Euroscale to simulate a European offset press, or DIC to 
simulate a standard Japanese offset press. For images that were separated using a 
custom separation (such as a device-specific separation or a separation produced 
with an ICC-profile), choose None as the CMYK Simulation setting. 
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Fiery WebTools allow you to manage your printer from the Internet or your 
company’s intranet. The Fiery 500 has its own home page, from which you can 
select a variety of tools.

About Fiery WebTools
You can access the Fiery WebTools over the network from a variety of platforms. 
The Fiery 500 functions as an Internet or intranet server, and has a home page 
that lets remote users view server functions and manipulate jobs. The client 
computer requires an Internet browser that supports Java. The recommended 
browser versions are:

• For Macintosh computers, Netscape Navigator 4.06 and later, 

• For Windows computers, Netscape Communicator 4.06 and later or Microsoft 
Internet Explorer 4.x and later.

Netscape and Microsoft continue to release frequent updates to their browsers. As 
support cannot be guaranteed for all versions, use the versions specified above for 
best results.

NOTE: Windows NT 4.0 users must download the Windows NT 4.0 Service 
Pack 3 or later, to run Fiery WebDownloader with Netscape Communicator 4.06. 
Fiery WebDownloader is available only for Windows computers.

For information about preparing the Fiery 500 for Fiery WebTools access, see 
Getting Started.

Chapter 6:
Managing 
Print Jobs
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You can access Fiery WebTools from the Fiery 500 home page.

Accessing Fiery WebTools
To use the Fiery WebTools via the Internet or your site’s intranet, you need an 
Internet browser and the IP address or DNS name of the Fiery 500.

TO ACCESS THE FIERY WEBTOOLS:

1. Start up your Internet browser application. 

2. Enter the IP address or the DNS name of the Fiery 500 in the URL line of your 
browser.

WebTool: Description:

Status Shows you the jobs currently processing and printing.

WebSpooler Allows you to view, manipulate, reorder, reprint, and delete jobs 
currently spooling, processing, or printing on the Fiery 500. 
Allows you to print the remainder of spooled Check and Print 
jobs and to view, print, and delete the Job Log. 

NOTE: WebSpooler is available only if your printer has an 
optional hard disk drive installed.

WebLink Provides a link to another web page, provided you have a valid 
Internet connection. You can set the WebLink destination. 

WebDownloader Allows you to download a PostScript or PCL file or PostScript 
Type 1 font file directly to the printer, without first opening the 
file in an application. 

NOTE: WebDownloader is available only for Windows 
computers.

WebSetup Allows you to view and change printer setup options, including: 
System Setup, Network Setup, and Printer Setup.
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Get the IP address or DNS name from your network administrator.

3. The Fiery WebTools home page appears. 

The individual Fiery WebTools are listed on the left. To display information about 
a particular tool, click the question mark next to its name. To launch one of the 
Fiery WebTools, click its name. 

Using Fiery WebSpooler
If your printer has an optional hard disk drive installed, Fiery WebSpooler lets you 
monitor and manipulate print jobs sent to the Fiery 500. All jobs sent to the 
printer appear in the Fiery WebSpooler window. You can view information about 
jobs, or copy, delete, or move jobs between queues.

NOTE: Fiery WebTools for Macintosh and Windows computers are fundamentally 
the same; differences are noted in this chapter. 
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Print jobs can be in one of the following queues:

NOTE: Job spooling requires a printer with an optional hard disk drive. All jobs are 
stored on the Fiery 500 hard disk until sent to the Print queue. 

Print Normal print jobs sent to the Fiery 500 appear in the Print 
queue. You can move and manipulate these jobs as described 
below.

Hold Jobs sent to the Hold queue remain in the Hold queue until 
they are moved to the Print queue or deleted. If you need to 
print the same document frequently, you can send it to the 
Hold queue and move a copy of the job to the Print queue 
every time you need to print it. You can also print large jobs to 
the Hold queue and then move them to the Print queue when 
other users are not printing.

Printed The jobs most recently sent to the Fiery 500 are saved in the 
Printed queue. You can drag these jobs back to the Print queue 
to print additional copies. By default the maximum number of 
jobs that can be saved in the Printed queue is 10. This number 
can be changed using the printer’s operation panel.

Check 
and Print

Jobs specified from the printer driver as Check and Print also 
appear in the WebSpooler window. These jobs can be moved 
to the Print queue.

NOTE: You can set the number of copies using the Override 
Print Settings option in the Edit menu.
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You can use the Fiery WebSpooler Job Log to view information about jobs printed 
to the Fiery 500 for job accounting or reference purposes. The Job Log can be 
printed to the Fiery 500 or exported as a file and viewed in other applications.

TO USE FIERY WEBSPOOLER:

1. On the left side of the Fiery WebTools home page, click the WebSpooler button.

The Fiery WebSpooler main window appears. 

Icons appear on buttons above the scroll list:

Update Click this button to update the information in the Fiery 
WebSpooler main window.

Duplica
te and 
Print

Drag a document onto this button or select the document and 
click this button to duplicate it and put the duplicate in the 
Print queue.
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The window is divided into regions that correspond to the different queues.

Each job listed includes the document name, user name, page description 
language (PCL or PS), and file size. 

The icons to the left of the job provides at a glance information about the jobs in 
each queue:

Print Drag a document onto this button or select the document and 
click this button to move it to the Print queue.

Hold Drag a document onto this button or select the document and 
click this button to save it in the Hold queue.

Delete/
Cancel

Drag a file onto this button or select the document and click 
this button to delete the file, or cancel its processing or printing. 
To eliminate the deletion verification notice, turn off the 
Confirm file deletion option in the Preferences window.

Printing Print icon The job that is currently printing appears in this list. It can be 
deleted to cancel printing.

Waiting Print icon Jobs that have been processed and are waiting to be printed appear 
in this list. To cancel these jobs, you can delete them. They are 
dimmed because their settings cannot be changed. Processing jobs 
can’t be moved or canceled.

Ripping RIP icon Jobs that are processing appear in the Ripping list. They are 
dimmed because their settings cannot be changed. Processing jobs 
can’t be moved or canceled.

Print Print icon Jobs that are waiting to be printed that have not been processed 
appear with the Print icon. Jobs in the Print list appear in the order 
they will be printed. 

Hold Hold icon Jobs in the Hold queue appear with the Hold icon. You can move a 
job to the Print queue to print it.
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2. Choose Preferences from the Edit menu to specify how Fiery WebSpooler operates.

You can use this window to specify that the Fiery 500:

Update Automatically every n seconds or update Manually—This option lets you 
specify whether the Fiery WebSpooler main window is automatically updated at a 
specified interval, or whether it is updated only when you choose the Update 
command from the Window menu or click the Update icon. By default, the Fiery 
WebSpooler main window is updated automatically every 20 seconds.

NOTE: When automatic updating is on, data is coming from the Fiery 500 across 
the network very frequently. This data adds to the network traffic, and might slow 
down other network jobs. For optimal network performance, turn off automatic 
updating. When you want to view updated informations, choose Update from the 
Window menu or click the Update icon.

Printed Printed 
icon

Jobs that have been printed are saved in the Printed queue and 
appear with the Printed icon. By default the number of jobs that 
may be stored in the Printed queue is 10. This number can be 
changed in the Printer Setup menu from the printer’s operation 
panel

Check 
and 
Print

Check and 
Print icon

If you selected the Check and Print option for your job, it will 
appear in the Check and Print area of the WebSpooler window 
with this icon. Once you have checked the job, you can use the 
Override Print Settings option of the Edit menu to send the other 
copies.

Printed Alert icon If a PostScript error occurred while a job was printing, the error 
appears in the Printed queue with an Alert icon next to it. You can 
double-click the Alert icon to display the error message.
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Confirm file deletion—Check this option if you want a confirmation dialog box to 
appear before you delete a file.

NOTE: This option applies to the current session only.

Duplicating, copying, moving, and deleting jobs
Users can copy, move, delete, and configure jobs for all users, and can reorder jobs 
within a queue. You can select more than one job at a time. To select multiple, 
adjacent jobs in the list, use Shift-click. To select multiple, non-adjacent jobs, use 
Ctrl-click (Shift-Ctrl-click on Macintosh).

Duplicating jobs

You can duplicate jobs in the Print, Printed, and Hold queues. When you 
duplicate a job, the Fiery 500 creates a reference to the original file, so duplicate 
files do not require the full amount of disk space on the Fiery 500. As long as one 
of the duplicates remain, the Fiery 500 saves the file, so you can delete all but one 
reference to a file.

TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.

2. Choose Duplicate Job from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.

2. Click the Duplicate and Print icon, or drag the job to the Duplicate and Print icon.

The job appears at the bottom of the Print queue. 

Copying and moving jobs

You can move your jobs from the Hold queue and the Printed queue to the Print 
queue. If you frequently print the same file, for example a fax cover sheet, you can 
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send it to the Hold queue and later drag a copy of the file to the Print queue. By 
copying rather than moving a job, you leave a copy of the job in the Hold queue 
so that you can easily print the job again later.

TO COPY A JOB TO ANOTHER QUEUE:

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.

2. Hold down the Option (Macintosh) or Ctrl (Windows) key as you drag the job to 
either the Hold or Print queue icon or to the Hold or Print section of the job list.

A copy of the job is moved to the queue you have selected, but the original job 
still appears in the Hold or Printed queue so that you can print the job at another 
time.

TO MOVE A JOB WITHIN A QUEUE:

1. Click the name of the job that you want to move. 

The selected job is highlighted.

2. Drag the file to the new location in the queue.

TO MOVE JOBS BETWEEN QUEUES:

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted.

2. Move the selected job to another queue by dragging it to the queue icon of your 
choice or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print queue by 
dragging the job to the Print queue icon. 
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TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete icon or click the Delete icon.

You can also choose Delete from the Edit menu to delete a selected job.

You can delete only your own jobs; system administrators who enter the password 
can delete any job. 

Changing print settings 
You can change the copy count for only Check and Print jobs in the Fiery 
WebSpooler main window.

You can override the copy count of a Check and Print job in the Override print 
settings dialog box. The settings in this dialog box override the settings in the 
operation panel Printer Setup menu.

TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a Check and Print job or select the job and choose Override Print 
Settings from the Edit menu.

The Override Print Settings window appears. 

2. Choose the new settings from the pop-up menus.

3. Click OK.

Using the Job Log
With Fiery WebSpooler, you can view and print a log of all the jobs printed to the 
Fiery 500. You can also export the Job Log as a tab-delimited text file and import 
into a database, spreadsheet or word processing application for job accounting 
purposes. All jobs printed to queues and to the direct connection are listed in the 
Job Log. Although jobs sent to the direct connection do not appear in the Printed 
queue, they do appear in the Job Log.
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TO DISPLAY, PRINT, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Window menu.

The Job Log window appears in a new browser window.

The Job Log window displays a list of all the jobs and the following information 
about them: status, document name, user name, file size, media type, number of 
color pages, page description language, number of originals, number of black and 
white or color pages, and total number of pages.

Use the scroll bar at the right of the window to view all fields in the Job Log 
window. 
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The text in the Status column provides information about the job:

2. To print the Job Log, choose Print Job Log from the WebSpooler File menu or click 
the Print icon above the list of jobs.

The information displayed in the Job Log window prints to the current Fiery 500. 
When you print the Job Log, totals are printed for all appropriate columns.

3. To save the Job Log as a file that you can view with a different application, 
choose Export Job Log from the WebSpooler File menu.

4. Enter a name for the log file, and click Save. 

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You 
can double-click ERROR to display the error message. A 
dialog box displays the PostScript error. Click OK to close 
the dialog box.

CANCEL The job was canceled before printing was completed.
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Checking the printer status
You can see what jobs are currently processing and printing with the Status 
WebTool.

TO ACCESS THE STATUS WEBTOOL:

• On the left side of the Fiery WebTools home page, click the Status button.

The Status window appears in a new browser window. 

You can close other browser windows and leave the Status window open to 
continue checking the status of the Fiery 500. As long as you keep the Status 
window open, it is dynamically updated.

The messages displayed in the Status window are explained in the following list:

Check input 
tray.

The paper path is open. Check tray to make sure they 
are closed and in place.

Close front 
cover.

The front cover is open. Close the cover to continue 
printing.

Close left cover. The left cover is open. Close the cover to continue 
printing.

Close paper exit 
cover.

The rear cover is open. Close the cover to continue 
printing.
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Cover open. The lower front cover or top cover is open. Close the 
cover to continue printing.

Door open. 
Check all doors.

One or more doors is open. Close the door to continue 
printing.

Idle The Fiery 500 is not processing or printing any jobs.

Load __ __ __. Load the appropriate media size and type in the 
corresponding tray.

Load Bypass __ 
__.

Load the appropriate media size and type in the Bypass 
tray.

Open front 
cover. Remove 
misfeed.

A paper jam has occurred. Remove jammed paper from 
drum to continue printing.

Paper misfeed. A paper jam has occurred. Removed jammed paper to 
continue printing.

Paper size error 
__. Open and 
close cover to 
clear.

The incorrect paper size was loaded in the indicated 
tray. Check the paper size setting for the indicated tray.

Paper too long. 
Clear jam. Load 
MP Tray __.

The media loaded in the MP Tray is longer than 
specified. Removing the remaining media and load the 
correct media type and size in the MP Tray.

Paper too short. 
Load MP Tray 
__ __.

The media loaded in the MP Tray is shorter than 
specified. Removing the remaining media and load the 
correct media type and size in the MP Tray.

Printing The Fiery 500 is printing a job.

Processing The Fiery 500 is processing a job so that it can be 
printed.
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NOTE: For a list of messages which appear on the operation panel, see Printer 
Reference.

Linking to other web sites
WebLink links you to the EFI home page (www.efi.com), provided a valid 
Internet connection is available. You can change the WebLink destination by 
holding down the Control key and clicking the WebLink button. In the New 
URL field, type the new WebLink address and click OK.

NOTE: Any change to the WebLink destination remains permanent until changed 
again.

Remove 
misfeed from 
input tray.

A paper jam has occurred. Removed jammed paper 
from input tray to continue printing.

Remove 
misfeed from 
output tray.

A paper jam has occurred. Removed jammed paper 
from feed area to continue printing.

Unexpected 
paper size MP 
Tray. Load __ 
__.

The paper size specified for this job does not match the 
size or type of media in the MP Tray. Printing stops 
until the problem is resolved.
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Viewing and modifying Setup options
You can remotely view and modify the current configuration of your printer using 
Fiery WebSetup, which provides remote access to the printer’s setup menu 
options: System Setup, Network Setup, and Printer Setup.

NOTE: Initial Printer Setup, specifically, setting the printer’s IP address, as well as 
its gateway, subnet mask, and password (if they are used), must be performed 
from the printer’s operation panel. Additional options may be specified using the 
control panel, or Fiery WebSetup.

For information on setting up the printer from the operation panel, see Getting 
Started.

TO ACCESS FIERY WEBSETUP:

1. On the left side of the Fiery WebTools home page, click the WebSetup button. 

If a password has been set on the printer, you will be prompted to enter it before 
you can access Fiery WebSetup.

For detailed information about Setup options, see Getting Started.
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2. Click the System Setup button. 

System Setup options appear in the System Setup tab. You can also access the 
Password from this window.

When you change an option, the Cancel and Save buttons flash on the screen. 

• Click Save to save a change made to the setting.

• Click Cancel to cancel the change.

NOTE: You must select either Cancel or Save before you can proceed to a different 
setup section or exit the WebSetup screen.
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3. Click the Network Setup button. 

Network Setup options appear in the Port Setup tab. You can also access Protocol 
Setup and Service Setup from this window.

When you change an option, the Cancel and Save buttons flash on the screen. 

• Click Save to save a change made to the setting.

• Click Cancel to cancel the change.

NOTE: If the Token Ring option is not installed in your printer, Token Ring 
options are dimmed.
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4. Click the Printer Setup button. 

Printer Setup options appear on the Printer setup tab. You can also access PS and 
PCL Setup from this window.

When you change an option, the Cancel and Save buttons flash on the screen. 

• Click Save to save a change made to the setting.

• Click Cancel to cancel the change.

NOTE: You must click either Save or Cancel before you can proceed or exit 
Fiery WebSetup.
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Using Fiery WebDownloader
Using Fiery WebDownloader, you can send PostScript, PCL, or text files to the 
printer without first opening the file in an application. You can also download 
PostScript and Adobe Type 1 fonts (*.pfb). When downloading fonts, be sure to 
check the Font box.

You can print a list of all resident printer fonts from the operation panel. See 
Getting Started for instructions on how to print a list of fonts. Appendix A of this 
manual lists all resident printer fonts included with the Fiery 500. 

NOTE: If your document uses TrueType fonts, they can be correctly printed by first 
converting them to Adobe Type 1 fonts.
For the Adobe PostScript printer driver for Windows 98 and Windows 95, click 
the Fonts tab and set up the Font Substitution table as necessary. 
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This appendix lists the built-in fonts included with your Fiery 500 printer.

NOTE: This product includes UFST font scaling technology under license from 
Agfa Division, Bayer Corporation.

The PCL font number appears in parentheses to the right of the font’s name.

PCL fonts
The Fiery 500 includes 46 fonts.

Intellifont Typfaces:

• Albertus Medium (27), Albertus Extra Bold (28)

• Antique Olive (19), Antique Olive-Bold (20), Antique Olive-Italic (21)

• CG Omega (5), CG Omega-Bold (6), CG Omega-Italic (7), CG Omega-
BoldItalic (8)

• CG Times (1), CG Times-Bold (2), CG Times-Italic (3), CG Times-BoldItalic 
(4)

• Clarendon Condensed (10)

• Coronet (9)

• Garamond Antiqua (22), Garamond Halbfett (23), Garamond Kursiv (24), 
Garamond Kursiv Halbfett (25)

• Letter Gothic (42), Letter Gothic-Bold (43), Letter Gothic-Italic (44)

• Marigold (26)

• Univers Medium (11), Univers Bold (12), Univers Medium Italic (13), Univers 
BoldItalic (14)

• Univers Medium Condensed (15), Universe Bold Condensed (16) Univers 
Medium Condensed Italic (17), Universal Bold Condensed Italic (18)

Bitmap font:

• Line Printer (45) 

Appendix A: 
Fonts and 
Font Utilities
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True Type fonts:

• Arial (29), Arial-Bold (30), Arial-Italic (31), Arial-BoldItalic (32)

• Courier (0), Courier-Bold (39), Courier-Italic (40), Courier-BoldItalic (41)

• Symbol (37)

• Times New Roman (33), Times New Roman-Bold (34), Times New Roman-
Italic (35), Times New Roman-BoldItalic (36)

• Wingdings (38)

PostScript fonts
Listed below are the 136 built-in PostScript printer fonts on the Fiery 500.

NOTE: All fonts that are pre-installed on your printer have also been included on 
the User Software CD. For information on how to install these fonts on your 
computer, see Getting Started.

Adobe Type 1 PostScript fonts
The Fiery 500 includes 117 Adobe Type 1 fonts:

• AlbertusMT, AlbertusMT-Italic, AlbertusMT-Light

• AntiqueOlive-Roman, AntiqueOlive-Bold, AntiqueOlive-Compact, 
AntiqueOlive-Italic

• AvantGarde-Book, AvantGarde-BookOblique, AvantGarde-Demi, 
AvantGarde-DemiOblique

• Bodoni, Bodoni-Bold, Bodoni-Italic, Bodoni-BoldItalic, Bodoni-Poster, 
Bodoni-PosterCompressed

• Bookman-Demi, Bookman-DemiItalic, Bookman-Light, Bookman-LightItalic

• Carta

• Clarendon, Clarendon-Bold, Clarendon-Light

• CooperBlack, CooperBlack-Italic

• Copperplate-ThirtyThreeBC, Copperplate-ThirtyTwoBC

• Coronet
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• Courier, Courier-Bold, Courier-Oblique, Courier-BoldOblique

• Eurostile, Eurostile-Bold, Eurostile-ExtendedTwo, Eurostile-BoldExtendedTwo

• GillSans, GillSans-Bold, GillSans-Italic, GillSans-BoldItalic, GillSans-
Condensed, GillSans-BoldCondensed, GillSans-Light, GillSans-LightItalic, 
GillSans-ExtraBold

• Goudy, Goudy-Bold, Goudy-Italic, Goudy-BoldItalic, Goudy-ExtraBold

• Helvetica, Helvetica-Bold, Helvetica-BoldOblique, Helvetica-Oblique

• Helvetica-Condensed, Helvetica-Condensed-Bold, Helvetica-Condensed-
BoldOblique, Helvetica-Condensed-Oblique

• Helvetica-Narrow, Helvetica-Narrow-Bold, Helvetica-Narrow-BoldOblique, 
Helvetica-Narrow-Oblique

• JoannaMT, JoannaMT-Bold, JoannaMT-Italic, JoannaMT-BoldItalic

• LetterGothic, LetterGothic-Bold, LetterGothic-BoldSlanted, LetterGothic-
Slanted

• LubalinGraph-Book, LubalinGraph-BookOblique, LubalinGraph-Demi, 
LubalinGraph-DemiOblique

• Marigold

• MonaLisa-Recut

• NewCenturySchlbk-Roman, NewCenturySchlbk-Bold, NewCenturySchlbk-
Italic, NewCenturySchlbk-BoldItalic

• Optima, Optima-Bold, Optima-Italic, Optima-BoldItalic

• Oxford

• Palatino-Roman, Palatino-Bold, Palatino-Italic, Palatino-BoldItalic 

• StempelGaramond-Roman, StempelGaramond-Bold, StempelGaramond-
Italic, StempelGaramond-BoldItalic

• Symbol

• Tekton

• Times-Roman, Times-Bold, Times-Italic, Times-BoldItalic



AA-4 Fonts
• Univers, Univers-Bold, Univers-BoldExt, Univers-BoldExtObl, Univers-
BoldOblique, Univers-Condensed, Univers-CondensedBold, Univers-
CondensedBoldOblique, Univers-CondensedOblique, Univers-Extended, 
Univers-ExtendedObl, Univers-Light, Univers-LightOblique, Univers-Oblique

• ZapfChancery-MediumItalic

• ZapfDingbats

TrueType fonts
The Fiery 500 includes 19 TrueType fonts:

• Apple-Chancery

• ArialMT, Arial-BoldMT, Arial-ItalicMT, Arial-BoldItalicMT

• Chicago

• Geneva

• HoeflerText-Regular, HoeflerText-Black, HoeflerText-Italic, HoeflerText-
BlackItalic, HoeflerText-Ornaments

• Monaco

• NewYork

• TimesNewRomanPSMT, TimesNewRomanPS-BoldMT, TimesNewRomanPS-
ItalicMT, TimesNewRomanPS-BoldItalicMT

• Wingdings-Regular
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additive color model
A system in which color is produced by 
combining primary lights additively. The 
additive primaries are red, green, and 
blue. When added together in proper 
amounts, these colors produce white. An 
RGB video monitor is based on an addi-
tive color model. 

additive primaries
Red, green, and blue light that is used in 
additive color systems. The additive pri-
maries combine to produce white.

banding
Visible steps between shades in a 
gradient.

bit depth
Amount of information required for 
each pixel in a raster image. Black and 
white images require only one bit per 
pixel. Photographic quality color images 
can require 24 or 32 bits per pixel.

Calibrated RGB
An RGB color space used by Fiery 500 
color management software as an inter-
change standard. The Calibrated RGB 
color space is defined according to the 
following specifications for a color moni-
tor: SMPTE phosphors, a white point 
D50, and gamma of 2.2.

calibration
The process of ensuring that a device 
behaves consistently with respect to a set 
of specifications. 

color gamut
See gamut.

color rendering dictionary (CRD)
A feature found in color printers that 
gives improved matching between the 
monitor and printed output. Color ren-
dering dictionaries are used by the 
printer’s interpreter when converting 
RGB data sent to the printer to CMYK 
data used by the print engine.

color rendering style
A feature of Fiery 500 color manage-
ment software that allows you to main-
tain the best possible translation of color 
from one color device to another. The 
Fiery 500 color rendering styles are: pho-
tographic, transparency and presenta-
tion.

color space
A model for representing color in terms 
of measurable values, such as the amount 
of red, green, and blue in an image. RGB 
and CMYK color spaces are based on 
color devices—monitors and printers 
respectively. Other color spaces, such as 
CIELAB are based on mathematical 
models, and are device-independent—
they are not based on the color response 
of a particular device.
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colorant
An ink, die, toner, paint or other pig-
ment that modifies the color of what it is 
applied to.

composite printer
Any printer that can print directly in 
color without first creating color separa-
tions. A composite is an early proof of a 
printing job.

continuous tone
An image containing gradient tones. 

custom color system
A system of named color swatches that 
can be matched on press using process or 
spot colors. PANTONE and TruMatch 
are examples of custom color systems.

density
A precise measurement of the light 
energy transmitted or reflected by a sur-
face in the presence of a standard light 
source.

densitometer
An instrument that measures density 
according to a specified standard. 
Status T densitometers are commonly 
used in the graphic arts industry. 

four-color printer
A printing device that uses cyan, 
magenta, yellow, and black ink or toner.

gamut
A range of colors. A device gamut is the 
range of colors that a device, such as a 
printer, can produce. An image gamut is 
the range of colors in a particular image.

gamut mapping
The process whereby Fiery 500 color 
management software compresses—
“maps”—the colors in a digital image to 
fit the color gamut of a particular device. 

gradient fill
A color or grayscale fill made of smooth 
transitions between two different colors 
or shades.

graphics device interface (GDI)
Graphics and display technology used by 
computers running Windows. GDI 
applications rely on GDI rather than the 
PostScript language to send words and 
pictures to printers.

halftoning
A method for representing an original 
continuous tone image using a pattern of 
dots of various sizes. The pattern is 
determined by the line frequency, screen 
angle, and dot shape. 

metamerism
Phenomenon where two colors com-
posed of different combinations of light 
wavelengths appear identical. The colors 
are called “metamers.”

moiré
An undesirable pattern in images made 
using halftone screens. Moiré can be 
caused by improper screen angles, 
improper alignment of halftone screens, 
or by certain types of patterns in the 
image itself.
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monitor color rendering
A color rendering style that matches 
printed colors to colors displayed on 
your computer’s monitor. Compared to 
presentation rendering, monitor render-
ing produces lighter, less purple blues as 
well as lighter, more olive greens. Use 
this style when you want to match mon-
itor colors to printed output.

named color
A color that is defined according to a 
custom color system. For example, PAN-
TONE 107 C is a named color.

offset lithography
Printing in which ink is transferred from 
printing plates to a rubber blanket and 
then from the blanket to paper.

photographic rendering
A color rendering style that preserves 
tonal relationships in images. Unprint-
able colors are mapped to printable col-
ors in a way that retains differences in 
lightness, slightly sacrificing color accu-
racy as necessary.

pixel
The smallest distinct element of a raster 
image or an image displayed on a 
monitor.

PostScript 3
Current version of Adobe Systems Post-
Script language, which is used to print 
and display pictures and text. PostScript 
3 includes many enhancements to older 
versions of PostScript, including 
improved quality and color with 

Enhanced Image Technology, faster per-
formance with Advanced Page Process-
ing, and ease of use and setup with 
NetWorks System.

prepress proof
A print made from a set of film separa-
tions, or from an electronic file, to simu-
late the results of printing. A film proof 
is the last opportunity to catch problems 
before the final printing.

presentation graphics rendering
A color rendering style that does not try 
to precisely match printed colors to dis-
played colors. It is appropriate for bright 
saturated colors used in illustrations and 
graphs.

process colors
The four ink colors used to simulate full-
spectrum color images: process yellow, 
magenta, cyan, and black.

QuickDraw
Graphics and display technology built 
into Macintosh computers. QuickDraw 
applications rely on QuickDraw rather 
than the PostScript language to send 
words and pictures to printers.

raster image
Electronic representation of a page or 
image using a grid of points (called pix-
els) that are numerically defined. Raster 
images can be black and white, grayscale, 
indexed color, or photographic quality 
color.
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separation
The process of separating a color image 
into the primary color components for 
printing—cyan, magenta, yellow, and 
black. Also used to refer to the four 
sheets of film that result from the process 
of separating a color image. 

solid color rendering
A color rendering style used when color 
accuracy is crucial. Unprintable colors 
are mapped to the closest printable col-
ors. It does the best job of preserving the 
saturation of displayed colors.

source profile
A profile used by Fiery 500 to determine 
the context for the color values specified 
in a digital image.

spot color
A color that is printed on its own separa-
tion plate when separations are specified. 
A spot color is printed using a special ink 
for that color, in contrast to process col-
ors that are printed using combinations 
of cyan, magenta, yellow, and black. 

subtractive color model
A system in which color is produced by 
combining colorants such as paint, inks, 
or dyes on media such as paper or trans-
parent film or acetate. The subtractive 
primaries are cyan, magenta, and yellow. 
All printing devices use the subtractive 
color model, as do photographs and 
transparency film. Many printers use 
cyan, magenta, yellow, and black colo-
rants.

subtractive primaries
Cyan, magenta, and yellow colorants 
used in subtractive color systems. Com-
bining the subtractive primaries pro-
duces darker colors.

SWOP
The abbreviation for Specifications for 
Web Offset Publications. A standard of 
specifications for separations, proofs, and 
color printing usually designed for maga-
zine production.

vector image
Graphic illustration created on comput-
ers where picture elements are defined 
mathematically as lines or curves 
between points. Includes artwork created 
in illustration and page layout applica-
tions. 
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A
accent color 1-10
additive color model 1-2
additive primaries 1-3
Adobe Type 1 PostScript fonts A-2
Apple Standard setting, RGB Source 

option 1-17

B
bit depth, of raster images 1-12, 1-14
Brightness 

option 1-16, 2-3, 3-9, 3-11, 4-10
built in fonts

PCL A-1
PostScript A-2

C
calibration

color 1-6
VisualCal 1-8

cancel
printing 6-6
processing 6-6

charts, using color in 1-10
Check and Print 

option 2-3, 3-9, 3-12, 4-10, 6-4
CIE color model 1-2
CMY color model 5-1
CMYK Color Reference 5-30
CMYK Simulation 

option 1-16, 2-3, 3-12
color

accent color 1-10
additive model 1-2
adjustment 1-8, 1-9
calibration 1-6
CMY model 5-1
complements 1-11

controlling printing results 1-5
custom color systems 1-11
HSB (hue,saturation, brightness) 5-1
HSL model 5-1
physics of 1-1
print options 1-16
properties of 1-1
RGB model 5-1
split complements 1-11
subtractive model 1-2, 1-3
subtractive primaries 1-3
text 1-11
theory 1-1
triads 1-11
using effectively 1-10, 1-11
wheel 1-11

Color adjustment, color calibration 1-8
Color Matching option 2-4
Color Mode option 2-4
color monitors, see monitors
Color Rendering Dictionary option 1-16
color rendering styles, see rendering styles
color space 1-2
color theory 1-1
color wheel 1-11
colorants 1-3
ColorSync System Profile 1-17
ColorWise Business Color 

option 3-9, 3-12, 4-11
ColorWise Expert Mode option 3-9, 4-11
Commission Internationale de l’Eclairage, 

see CIE color model
complements, color 1-11
compression, JPEG 5-9, 5-10, 5-11
computer monitors, see monitors
configuring PCL printing options

Windows 95 4-1
Windows NT 4-6
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configuring PostScript print options
Mac OS 2-1
Windows 95 3-1
Windows NT 4.0 3-6

Confirm file deletion option 6-8
conventions used xii
copying jobs in Fiery WebSpooler 6-9
CorelDRAW 7.0 for Windows 5-21–5-22

D
default color controls set in Setup 1-16
deleting jobs in Fiery WebSpooler 6-10
Device Options 3-9, 4-11
documentation xi
duplicating jobs in Fiery WebSpooler 6-8

E
EFICOLOR

profiles 5-18
XTension 5-18

EFIRGB setting, RGB Source 
option 1-17

Electronic Collation 
option 2-4, 3-10, 4-11

EPS (Encapsulated PostScript) 5-8

F
Fiery WebDownloader 5-30, 6-2, 6-20
Fiery WebLink 6-2
Fiery WebSpooler

copying jobs 6-9
deleting jobs 6-10
description 6-2
duplicating jobs 6-8
moving jobs 6-9
preferences 6-7
using 6-3

Fiery WebStatus 6-2, 6-13
Fiery WebTools

accessing 6-1
home page 6-1
overview 6-1

requirements for 6-2
file size, of raster images 1-14
fonts

color text size 1-12
PCL A-1

FreeHand 7.0 for Macintosh and 
Windows 5-19–5-21

G
gamut

mapping 1-4
of print devices 1-4, 1-5
out-of-gamut colors 1-18
photographic transparencies 1-4

GDI applications, using color in 5-1
Graphics Device Interface, see GDI
graphs, using color in 1-10
Grayscale option 3-13

H
Hold queue 6-4
HSB (hue, saturation, brightness) 1-2
HSB color model 5-1
HSL color model 5-1

I
ICC rendering styles 1-18
ICM profiles and Microsoft Office 97 5-3
Illustrator 7.0 for Macintosh and 

Windows 5-19–5-29
Internet Explorer 6-1

J
Job Log 6-5, 6-10
JPEG 5-9, 5-10, 5-11

L
light, as property of color 1-1
line art, see vector images

M
Mac OS
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printing from 2-1
Media Type option 2-5, 3-13, 4-12
metamerism 1-2
Microsoft Internet Explorer, see  Internet 

Explorer
Microsoft Office 97 and ICM profiles 5-3
misregistration of colors 1-12
monitors 1-3
moving jobs in Fiery WebSpooler 6-9

N
networks

using printer on xi

O
office applications 5-1
out-of-gamut RGB colors, printing 1-18
overview of manual xi

P
PageMaker 6.5 for Macintosh and 

Windows 5-12–5-15
painting applications 1-12
PANTONE Coated Color 

Reference 5-30
Paper Size option 2-5, 3-10, 3-13, 4-12
Paper Source option 2-5, 4-12
Paper Tray option 3-10, 3-13
PCL

built in fonts A-1
font numbers A-1

PCL printing
Windows 95 4-1
Windows NT 4.0 4-6

phosphors 1-3
photographic prints 1-3
Photographic rendering style 1-18, 2-4
photographic transparencies 1-3, 1-4
Photoshop 5.0 for Mac OS and 

Windows 5-3–5-11
physics of color 1-1
pixel-editing applications 1-12, 1-14

pixels in raster images 1-12
PostScript applications, using color 

in 5-29
PostScript fonts

list A-2
PostScript printing

Mac OS 2-1
Windows 95 3-1
Windows NT 4.0 3-6

preferences 6-7
prepress proof 1-5
presentation print jobs

rendering styles appropriate for 1-18
using color in 1-10

Presentation rendering style 1-18, 2-4
print devices

consistency 1-5
gamut 1-4, 1-5
test prints 1-6
see also  printer

print options
Mac OS 2-3
Windows (PCL) 4-10
Windows (PostScript) 3-9

Print queue 6-4, 6-14
Printed queue 6-4
printer

calibrating 1-6
maintenance 1-6
paper stock 1-5
print options 2-3, 3-9, 4-10
recalibrating color output 1-6
rendering style 1-18
toner 1-5
see also print devices

printer description files 2-1
printing

calibration pages 1-6
from serial port 2-1
raster images 1-13

process colors 1-3, 5-30
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Q
QuarkXPress 3.32 for Macintosh and 

Windows 5-12–5-13, 5-18
QuickDraw applications 5-1

R
raster images

bit depth 1-12, 1-14
definition 1-12
file size 1-14
for offset press printing 1-15
printing 1-13
resolution 1-12, 1-13, 1-15
scaling 1-15

registration of colors 1-12
Release Notes xi
rendering styles 1-18, 5-2
resolution of raster 

images 1-12, 1-13, 1-15
RGB color model 5-1
RGB Source 

option 1-16, 1-17, 2-5, 3-11, 3-13
RGB TIFF images, importing into 

Illustrator 7.0 5-28

S
scanners 1-2, 1-3
See also manuals
serial port printing 2-1
Setup, default color controls set in 1-16
spectral components of light 1-1
split complements 1-11
sRGB (PC) setting, RGB Source 

option 1-17
subtractive color model 1-2, 1-3
subtractive primaries 1-3

T
test prints 1-6
text

font size 1-12

using color with 1-11
TIFF images

preview 5-8
recommended for imported 

images 5-8
transparencies, photographic 1-3, 1-4
Transparency (OHP) rendering style 2-4
triads, color 1-11
troubleshooting printing problems 1-6
TrueType fonts A-4

V
vector images 1-12, 1-15
visible spectrum of light 1-1
VisualCal calibration method 1-6

W
Watermark option 3-11, 4-12
Windows

PCL print options 4-10
PostScript print options 3-9

Windows Graphics Device Interface, see 
GDI applications

Windows 95
configuring PCL printing options 4-1
configuring PostScript printing 

options 3-1
Windows NT 4.0

configuring PCL printing options 4-6
configuring PostScript printing 

options 3-6
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